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1 Executive Summary 
 
A Glass Furnace Model (GFM) was developed under a cost-shared R&D program by the 
U.S. Department of Energy's Argonne National Laboratory in close collaboration with a 
consortium of five glass industry members:  Techneglas, Inc., Owens-Corning, Libbey, 
Inc., Osram Sylvania, Inc., and Visteon, Inc.  Purdue University and Mississippi State 
University's DIAL Laboratory were also collaborators in the consortium. 
 
The GFM glass furnace simulation model that was developed is a tool industry can use to 
help define and evaluate furnace design changes and operating strategies to:  1) reduce 
energy use per unit of production; 2) solve problems related to production and glass 
quality by defining optimal operating windows to reduce cullet generation due to rejects 
and maximize throughput; and 3) make changes in furnace design and/or operation to 
reduce critical emissions, such as NOx and particulates. 
 
A two-part program was pursued to develop and validate the furnace model.  The focus 
of the Part I program was to develop a fully coupled furnace model which had the 
requisite basic capabilities for furnace simulation.  The principal outcome from the Phase 
I program was a furnace simulation model, GFM 2.0, which was copyrighted.  The basic 
capabilities of GFM 2.0 were: 1) built-in burner models that can be included in the 
combustion space simulation; 2) a participating media spectral radiation model that 
maintains local and global energy balances throughout the furnace volume; and 3) a 
multiphase (liquid, solid) melt model that calculates (does not impose) the batch-melting 
rate and the batch length. 
 
The key objectives of the Part II program, which overlapped the Part I program were:  1) 
to incorporate a full multiphase flow analytical capability with reduced glass chemistry 
models in the glass melt model and thus be able to compute and track key solid, gas, and 
liquid species through the melt and the combustion space above; and 2) to incorporate 
glass quality indices into the simulation to facilitate optimization studies with regard to 
productivity, energy use and emissions. 
 



Midway through the Part II program, however, at the urging of the industrial consortium 
members, the decision was made to refocus limited resources on transfer of the existing 
GFM 2.0 software to the industry to speed up commercialization of the technology.  This 
decision, in turn, necessitated a de-emphasis of the development of the planned final 
version of the GFM software that had full multiphase capability, GFM 3.0.  As a result, 
version 3.0 was not completed; considerable progress, however, was made before the 
effort was terminated. 
 
The objectives of the Technology Transfer program were to transfer the Glass Furnace 
Model (GFM) to the glass industry and to promote its widespread use by providing the 
requisite technical support to allow effective use of the software.  GFM Version 2.0 was 
offered at no cost on a trial, six-month basis to expedite its introduction to and use by the 
industry.  The trial licenses were issued to generate a much more thorough user beta test 
of the software than the relatively small amount completed by the consortium members 
prior to the release of version 2.0. 
 
Eighteen no-cost trial licenses were issued to twelve different companies.  The feedback 
received during interaction with the early trial licensees revealed substantial ease of use 
issues with the graphical user interface and control program and significant robustness 
problems in both the combustion space and melt space computational fluid dynamics 
(CFD) programs of the GFM software package.  This result was not unanticipated in 
view of the fact that the GFM Development Program ended before beta testing of GFM 
Version 2.0 could be completed. 
 
A review of the feedback from the initial users and the GFM software components 
yielded a substantial list of improvements to GFM that would be needed to bring the 
software to a point where a new version could be released that addressed the ease of use 
and robustness issues.  The decision was made to suspend the licensing effort and to 
develop and implement the necessary improvements.  Section 3 of this document 
describes the major changes and additions to GFM Version 2.0 that were made and that 
are included in the final GFM Version 4.0.  It also includes background information 
where needed to provide a complete description of the GFM software and to facilitate its 
use.  The appendices include additional information on the components of the technology 
and guidance on how to use GFM 4.0.  The appendices are also included in the software 
package as user documentation for version 4.0 and are available electronically via the 
Help Menu while using the software. 
 
Results from initial testing of GFM 4.0 are given in Section 4.0.  The test problem chosen 
simulates hypothetical 20 ton/day and 40 ton/day regenerative glass melting furnaces 
coupled to the glass melt specified by Technical Committee 21 (TC21) of the 
International Commission on Glass (IGC).  The specifications for these test problems are 
in Appendix 7.  These test cases were chosen as the base cases for testing upgrades in 
GFM 4.0 because results can be compared with those of other glass modelers from 
around the world who are members of the TC21 committee of the IGC.  The flow 
patterns, temperature distributions, batch coverage, and other results from the test 
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problems are within the range of those obtained by other modelers running the test 
problem. 
 
Version 4.0 of the Glass Furnace Model with the extensive enhancements and model 
upgrades described in Section 3 and the Appendices has been released.  GFM can be 
ordered via Argonne's Office of Technology Transfer Software Shop web site: 
 
http://www.anl.gov/techtransfer/Software_Shop/GFMSoftware/GFM_Software.html 

 
 
 

2 Background and Objectives 
 

2.1 Background 
 
The Glass Furnace Model (GFM) software was developed under a cost-shared R&D 
program by the U.S. Department of Energy's Argonne National Laboratory in close 
collaboration with a consortium of five industry members: Techneglas, Inc., Owens-
Corning, Libbey, Inc., Osram Sylvania, Inc., and Visteon, Inc.  Purdue University and 
Mississippi State University's DIAL Laboratory were also collaborators in the 
consortium.  The program was initiated in response to competitive and regulatory 
pressures. The glass manufacturers sought means to improve productivity and product 
quality, and reduce furnace energy use and emissions. 
 
The GFM glass furnace simulation model that was developed is intended to be a tool 
industry can use to help define and evaluate furnace design changes and operating 
strategies to: 
 

• Reduce energy use per unit of production, 
• Solve problems related to production and glass quality by defining optimal 

operating windows to reduce cullet generation and maximize throughput, and 
• Make changes in furnace design and/or operation to reduce critical emissions, 

such as NOx and particulates. 
 
To meet these needs, the goals of the GFM software analysis tool development were to 
provide a tool that could be run on readily available commodity computers, that would be 
as easy to use as possible given the complex analysis task to be accomplished, and that 
would have sufficient modeling capability to yield the desired useful results from the 
analysis. 
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2.2 GFM Software Development Program Description and 
Objectives 

 
A two-part program was pursued to develop a furnace model that would provide the 
industry with the desired capabilities.  The focus of the Part I program was to:  (1) 
construct and validate a computational fluid dynamics (CFD) based combustion space 
model that incorporates a direct solve of the radiation heat transfer equation throughout 
the whole furnace volume using a wide band model for spectral radiation from 
combustion species such as H2O and CO2 and radiation to and from the crown; (2) 
develop a simulation of the glass melt with Argonne's CFD code which has inherent 
multiphase flow capabilities and directly incorporate models of the glass batch and foam 
region; (3) couple the combustion space and glass melt models into a simulation of a 
selected furnace; (4) make measurements in selected furnaces of key furnace operating 
parameters to provide a data base for validation of the GFM model; and (5) conduct 
extensive validation studies of the furnace model.  The principal outcome from the Phase 
I program was GFM 2.0, which was copyrighted.  The basic capabilities of the GFM 2.0 
code were: 
 

• Built-in burner models that can be included in the combustion space simulation. 
• A computationally efficient spectral radiation model that maintains local and 

global energy balances, 
• A multiphase (liquid, solid) melt model that calculates (does not impose) the 

batch-melting rate and the batch length). 
 
The key objectives of the Part II program which overlapped the Part I program were to 
(1) incorporate reduced glass chemistry models into the glass melt and thus be able to 
compute and track key solid, gas, and liquid species throughout the melt; 2) activate the 
gaseous phase transport equations built into the glass melt model with source terms 
derived from the chemistry models to compute gaseous species production, bubble 
nucleation and growth, dissolution, and release from the glass melt surface (foaming); (3) 
develop and incorporate chemistry and nucleation models of particulate formation for the 
gases emanating from the glass melt and batch into the combustion space; (4) develop 
and incorporate glass quality indices into the simulation to facilitate optimization studies 
with regard to productivity, energy use and emissions, (5) develop and validate furnace 
simulations of additional furnace types used in the industry, (6) have industry participants 
evaluate the code by functioning as beta test sites and conducting extensive parametric, 
sensitivity, and optimization studies of each furnace simulated, and (7) transfer the final 
version GFM 3.0 along with all data and information generated in the program to the 
industry. 
 
Midway through the Part II program, however, at the urging of the industrial consortium 
members, the decision was made to refocus on transfer of the existing code GFM 2.0 to 
the industry to speed up commercialization of the software technology.  A technology 
transfer program described in the following section was therefore developed and initiated. 
This decision, in turn, necessitated a de-emphasis of the development of the planned final 
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version of the GFM code that had full multiphase capability, GFM 3.0.  As a result, 
version 3.0 was not completed.  However, limited progress was made in a number of 
areas: (a) developing glass chemistry models for inclusion in the glass melt code to 
provide source terms for gas bubbles and hence foam production, (b) bubble transport 
and surface bursting modules were added to the melt code, (c) development of chemistry 
and particulate models for products released from the glass melt and batch into the 
combustion space were initiated; this effort is approximately 50% complete, (d) a module 
using a Runge-Kutta 4 algorithm for massless particle tracking was implemented in the 
melt code to form the basis for computing quality indices including residence time, 
melting index, refining factor, and temperature index. 
 

2.3 Technology Transfer Program 
 
2.3.1 Technology Transfer Program Description and Objectives 
 
The basic objectives of the Technology Transfer program were to transfer the Glass 
Furnace Model (GFM) to the glass industry and to promote its widespread use by 
providing the requisite technical support to allow effective use of the software.  The 
project objectives were to be accomplished through the following actions, which were 
implemented.  A brochure was prepared that described the capabilities of the code and 
the support that would be provided to the user.  The brochure was mailed to a broad 
spectrum of glass industry representatives. The GFM Version 2.0 was placed in 
Argonne's Software Shop on the internet and was readily available for licensing on-line 
through the laboratory's Office of Technology Transfer. Technical support was provided 
to the code users and a GFM software code user group (CUG) was established by setting 
up a web site where users could report problems and share information on using the 
software. Every licensee automatically became a member of the CUG and was entitled to 
receive technical support at no cost throughout the duration of the technology transfer 
program. The level of support provided was planned to be sufficient to allow the licensee 
(user) to become proficient in the use of the software. The assumption was that the 
interested users would devote the necessary time to master the use of the software.  
Training at Argonne was offered to all new users.  
 
The CUG members were expected to meet periodically to discuss their experience and 
the results derived from the use of the code. While no formal CUG meetings took place, 
licensees did provide feedback to Argonne at Glass Manufacturing Industrial Counsel 
(GMIC) and DOE glass portfolio project status meetings. Further improvements in the 
software were expected to be part of the technical support activity that would evolve from 
user feedback and would be incorporated into the software. At the conclusion of this 
program, the CUG members were expected to define a mechanism that they would 
implement for provision of any additional support they would need in the long term. 
 
2.3.2 Technology Transfer Program Status 
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Initially, GFM Version 2.0 was offered at no cost on a trial, six-month basis to expedite 
its introduction to and use by the industry.  The no-fee trial license could be readily 
accessed on-line from the Argonne Software shop.  During the trial period, users were 
invited to Argonne to learn how to use the software, set up furnace simulations with the 
graphical user interface (GUI), and evaluate the computational results with the post-
processor.  The trial licensees were encouraged to apply the GFM software to evaluate 
and resolve a specific furnace design or operating problem, and thus allow the 
development team to assess the GFM software Version 2.0.  The trial licenses were 
intended to result in a much more thorough beta testing of the software than the small 
amount completed by the consortium members prior to the release of version 2.0. 
 
Eighteen no-cost trial licenses were issued to twelve different companies.  Staff from 
eight of the companies received various levels of training on the use of the GFM 
software.  The feedback received during interaction with the early trial licensees revealed 
substantial ease of use issues with the graphical user interface and control program and 
significant robustness problems in both the combustion space and melt space 
computational fluid dynamics (CFD) programs of the GMF software package.  This 
result was not unanticipated in view of the fact that the GFM Development Program 
ended before beta testing of GFM Version 2.0 could be completed.  Also, only one 
member of the GFM development team could participate in the Technology Transfer 
program, due to limited available resources, and that engineer left Argonne in the middle 
of the Technology Transfer program. 
 
Upon the departure of the last GFM development team member, the project was taken 
over by a CFD development engineer who had a thorough knowledge of the underlying 
CFD codes. A review of the feedback from the initial users and the GFM software 
components yielded a substantial list of improvements to GFM that would be needed to 
bring the software to a point where a new version could be released that addressed the 
ease of use and robustness issues.  The decision was made to suspend the licensing effort 
and implement the improvements.  Section 3 of this document describes the major 
changes and additions to GFM Version 2.0 that are included in GFM Version 4.0.  It also 
includes background information where needed to provide a complete description of the 
GFM code and to facilitate its use.  Results from initial testing of GFM 4.0 are given in 
Section 4.  The appendices provide additional information and guidance on how to use 
GFM 4.0.  These appendices are also included in the software package as user 
documentation for version 4.0 and are available electronically via the Help Menu while 
using the software. 
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3 The Glass Furnace Model Version 4.0 Technology 
 

3.1 Overview of Glass Furnace Model Version 4.0 Computer 
Software  

 
The Glass Furnace Model (GFM) Version 4.0 computational fluid dynamics (CFD) and 
radiation heat transfer computer simulation system computes the reacting gas flow in the 
combustion space and the particulate solid and liquid melt flow in the glass melt of a 
glass furnace and couples them through a spectral radiation model to create the overall 
furnace model. GFM 4.0 is a complete analysis system, including pre- and post-
processors. GFM software includes the tools to define the geometry and parameters of a 
furnace simulation, execute and monitor the progress of the simulation, and visualize the 
results.  
 
3.1.1 Areas of Major Improvement in Version 4.0 
 
Based upon the feedback received from the initial licensees of GFM Version 2.0, the 
following areas were identified where significant improvements were needed.   
 

• installation procedure 
• ease of use of the graphical user interface and control program, 
• robustness and numerical stability of both the combustion and melt CFD 

programs 
• coupling of the two furnace domains 
• computational efficiency of the combustion and melt CFD programs, 
• efficiency and accuracy of the participating media radiation heat transfer 

algorithm, and 
• summary and convergence data that allow assessment of a simulation. 

 
All of the core package improvement areas have been addressed and greatly enhanced in 
GFM 4.0.  The scope of the changes is quite substantial. The table below gives some hard 
data relating to the magnitude of the upgrade. It does not include line counts for portions 
of the software that have been rewritten or counts of extensive comments added to 
existing lines to make it feasible to maintain the code with much less effort in the future. 
The number of new executable instruction and commentary lines of code has nearly 
doubled.  
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Table 1: Lines of GFM Code 
 

 
Code 

 
GFM 2.0 

 
GFM 4.0 

 
Growth 

Combustion 10956 21728 10772 
Melt 11103 16565 5462 
GUI 8905 17203 8298 

    
Totals 30964 55496 24532 

 
 
3.1.2 GFM 4.0 Capabilities 
 
The following capabilities are new in GFM Version 4.0: 
 

• A modern installer, reducing the installation time to just a few minutes without 
the need to read any documentation. 

• A simplified user interface that corresponds more closely to user tasks needed to 
define a glass furnace and operating parameters for simulation. 

• Automated file handling for simulation setup and control.  Simulations are now 
set up as cases, and the user no longer needs any knowledge about file types or 
file contents. 

• Automated cycling between the combustion and melt space computations in 
coupled simulations.  This capability can shrink the time to obtain a converged 
coupled solution of combustion and melt spaces in a modeled furnace from a 
couple of weeks to a couple of days. 

• A relaxation scheme applied to the coupling conditions between the melt and 
combustion spaces to damp numerical instabilities in cycling the computation 
between the combustion and melt. 

• A new hybrid radiation computation that greatly improves the accuracy of the 
wall temperature computation. 

• An automated soot model calibration procedure. 
• The use of NIST thermodynamic property relations in the gas phase temperature 

and enthalpy relations. 
• A new status monitoring program, RunPlot, that plots convergence measures, 

average temperatures, and global heat distribution on screen during the course of 
a simulation.  RunPlot makes it easy to see how a simulation is progressing and 
when temperatures and heat transfer rates have stabilized indicating that the 
simulation is done.  RunPlot also makes it easy to spot problems in a simulation 
and take steps to correct them. 

• Simulation summary files that contain detailed information on global mass and 
energy balances. 

• A large number of other improvements in the models and algorithms. 
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More detailed descriptions of the technology enhancements implemented in GFM 4.0 are 
presented in the following sections. 
 

3.2 Ease of Use and Computer Hardware Requirements 
 
GFM has a graphical user interface that provides a straightforward means to build a 
model of a glass furnace and define material properties and operation conditions by using 
the preprocessor. In addition, GFM has a post processor that facilitates the display of the 
simulation results. Use of the software requires an appropriate engineering and glass 
technology background. Some familiarity with modeling and simulation is also required. 
Ease of use enhancements are discussed in detail in Section 3.4, which covers 
enhancements to the user interface and control program. 
 
GFM runs on most currently available computers under the Microsoft Windows® 
operating system. It has been tested on both Windows®2000 and Windows®XP operating 
systems. GFM is computationally intensive software that runs single core CPUs at near 
100% load. This characteristic may cause overheating if GFM is run on laptop 
computers. GFM runs best on workstation level computers with 2GB of memory.  
 

3.3 Automated Installer Replaces Manual Installation 
Procedure 

 
A newly developed GFM installer/uninstaller package replaces the previous manual 
installation procedure. The automated modern installer reduced the installation time to 
just a few minutes without the need to read any documentation. The previous manual 
installation procedure required the user to build a directory structure and populate it with 
files from the distribution CD. All of the components of the GFM package were 
incorporated into the new modern Windows® installer interface.  
 
The installer includes an option to install included Visual Basic (VB) 6 runtime files for 
those machines that require these files to successfully run GFM. License holders will no 
longer need to buy and install Visual Basic in order to get GFM to run on systems that do 
not have the Visual Basic 6 runtime files present. The user id and password system that 
was required whenever GFM was run for the purpose of copy protection has been 
replaced by a standard serial number system where serial numbers are assigned to 
licensees, and the serial number is checked at the time of installation. Program and 
licensee information are also saved in the windows registry upon installation, and this 
information is checked every time the program is run. The installer automates the 
installation process, including building and populating the directory structure for the 
GFM package, creating start menu items, adding an optional desktop icon, and taking the 
user through pages with the license agreement and copyright notice. The welcome and 
options pages of the install procedure are shown in Figure 1. The install process is very 
quick and can be completed in a few minutes. 
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Old install procedure was 
manual and did not provide 
VB runtime files needed on 

some systems. 

New install uses a standard 
installer with option to install 

VB runtime files. 
Provides start menu item, 
desktop icon, populated 

directory structure, uninstall 
program, etc. 

Figure 1.  Welcome and component options pages for new modern installer written for GFM 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The uninstall program deletes GFM information from the registry and the GFM 
executable files, but it will not delete user generated case files.  
 

3.4 Graphical User Interface and GFM Control Program 
 
An attempt was made to keep the general “look and feel” of the graphical user interface 
(GUI) that was familiar to users of previous versions, however many modifications were 
required. The main GUI changes that improve ease-of-use and support CFD code 
enhancements are discussed in the following sections. Note that numerous problems and 
inconsistencies were also corrected, but are not listed here. 
 
3.4.1 Simplified User Interface 
 
The user interface was simplified to correspond closely to user tasks needed to define a 
glass furnace and operating parameters for simulation. Previously the portions of the user 
interface used to enter information for a simulation were organized around building the 
files used by the combustion space and melt space programs. From a user’s perspective, 
the system to be simulated needs to be defined, then the simulation is performed, and 
finally results are reviewed. System definition includes specification of furnace geometry, 
material properties, and operating conditions. Some additional information is also needed 
such as whether to simulate only the combustion or melt space or to perform a coupled 
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simulation that cycles between the melt and combustion spaces. The user interface is now 
organized to make tasks required to define, run, and review a simulation as 
straightforward as possible. 
 
3.4.2  Automated File Handling 
 
Automated file handling was implemented with a case based setup, control, post 
processing, and file management scheme. The user’s work is now based on simulation 
cases, and the GFM control program manages the case files. This automation step is very 
significant because detailed knowledge of the operation of the combustion space code, 
the melt space code, and the information contained in the various files that they use was 
needed previously to make decisions about when to load and save files when setting up a 
simulation within the GUI. The user is now relieved of the burden of needing this 
knowledge to set up and run a simulation.  
 
Working with cases is very simple. The file menu allows the user to create a new case, 
delete a case (or only delete the results of running a case), save a case, save a case as a 
new case (or only save the setup files as a new case), open an old case to continue work 
on it, and update case descriptions or notes. The “save case as” function provides the user 
with a means to make a copy of a case (all of the case files are assigned the new case 
number) that can be used to run a new simulation of the same furnace with one or more 
operating or geometry parameter changes (Figure 2). 
 
 
 
 
 
 
 
 
 
 
 

File menu with no 
case open 

File menu with  
case open 

Figure 2.  Simplified User Interface with Automated File Handling 

 
 
 
 
 
 
 
 
Case files are organized in case folders by the user interface and control program. The 
number of files generated to support a simulation case has expanded greatly. Organizing 
these case files into separate folders in the directory tree greatly simplifies file 
organization, providing a simpler interface to cases in menu system and dialog boxes. 
This file organization is also ideal for users who want to manually copy or backup case 
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files to other locations or media, such as CD or DVD. Appendix 4 provides a guide to the 
GFM files. 
 
3.4.3  New Menu Organization in the User Interface 
 
The menu system was restructured to correspond much more closely to the normal user 
work flow of preparing a case for simulation, running and monitoring the simulation, and 
reviewing the simulation results. The steps required are described in two examples 
included in Appendix 3. User actions are clearly segregated into pre-process, simulation, 
or post-process environments. A menu layer indicator was added to the user interface and 
control program to allow the user interface to be made context sensitive in a 
straightforward manner, eliminating many combinations of user inputs that previously led 
to program lockups. 
 
The menu system was reorganized to bring it more in line with that of a common 
windows application, improving usability of the program. This effort included: 
 

• Many menu items were renamed to more clearly indicate the function of the menu 
item.  

 
• Submenu items were removed when their use was not appropriate under the 

parent menu item. Menu items that are needed under some conditions, depending 
on the context, are now grayed out and unavailable when their use is not 
appropriate. 

 
• Some menu items that provided shortcuts between the different work 

environments or actions that were not related to the tasks in a work environment 
were removed because they increased the likelihood of software lockups and 
other serious system errors when the menu item was present for convenience but 
not needed for functionality. 

 
Appendix 2 describes the menu items, sub-items, and their use. 
 
3.4.4  Error Trapping and Warning Messages 
 
Extensive error trapping and error prevention were designed into the enhanced user 
interface. Many user errors that previously resulted in abnormal program termination and 
loss of work are now prevented by various means, such as making actions inaccessible in 
the menu system under conditions where their initiation leads to inconsistent program 
states. Invalid user actions are prohibited by graying out and disabling menu items that 
should not be executed (clicked) at a given point in the user work flow.  
 
Under the philosophy that warning messages improve usability by helping a user avoid 
mistakes, a large set of error, warning, and information messages was implemented. In 
particular, a mechanism to notify the user if an action would result in loss of user data 
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Figure 3.  Warning messages improve usability by helping the user avoid mistakes 

Figure 
3
was added. Several examples of warning and information messages are shown in 
. 

 
New routines were added to gracefully close a work environment such as melter 
geometry and parameter construction, with dialog boxes asking the user if they wish to 
save the case if changes have been made and the case has not been saved. Similar 
changes were implemented to the routine that exits the entire GFM application. 

 
The user is warned if they attempt an action that would interrupt simulation or terminate 
a simulation that is in progress. They are given the option to immediately terminate the 
simulation, continue to a point where restart files can be saved, or simply to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.4.5 Furnace Figure and Grid View Environment in Geometry 
Specification 

 
Functions to enable the user to go back and forth between the figure (schematic) view 
and the grid view environment were added via a "view" menu item. The figure view 
environment is used to define the furnace dimensions, position of inlets and outlets, and 
specify run parameters and physical properties. The grid view environment is used to see 
and optionally adjust the representation of the figure as a set of discrete computational 
cells (i.e., the grid) that is passed as input to either the melt or combustion CFD codes. 
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In addition to convenience (the grid can be reconstructed and viewed as each burner, 
exhaust, etc. is added), this feature enables the capability to easily create a sequence of 
parametric runs with varying properties. 
 
 
 
 
 Figure 

View  
 
 
 
 
 
 
 
 
 
 
 
 
 

Grid 
View 

 
 
 
 
 
 
 
 
 Figure 4.  Figure and grid views of default combustion space 
 

Figure 5.  Same grid views in 3D showing exit plane and inlet plane 
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Figure 4 and  show examples of figure and grid views in the combustion space 
environment. 

Figure 5

 
3.4.6  Protecting User Grid Edits While Enabling New Parametric 

Case Creation Capability 
 
In GFM 4.0 a series of parametric runs can be done for grids containing user edits (for 
example one containing user added local refinement around a burner that is not part of 
the automatic grid generation) without the user having to reapply the grid edits for each 
case. If a user made hand edits to the grid in the grid view, saved the grid, and ran a case, 
previously there was no way to start the program up again and make changes to flow 
rates, inlet temperatures, or other conditions and run the new case without reconstructing 
the grid, which would destroy any user edits made to the grid. 
 
A mechanism was added to inhibit actions that would require grid reconstruction when a 
user indicates that they do not want to change their grid by checking menu option 
“Protect Grid Edits”. When the user makes hand edits to a grid, the grid will 
automatically be "locked" (put in grid protect mode) with respect to the ability to add or 
modify objects such as burners in the figure view. However, all the menu items and list 
boxes that provide access to the various run parameters in the figure view environment 
are accessible, and any parameter that does not require a reconstruction of the grid can be 
modified and the case can be run without destroying the user's hand edits to the grid. 
Thus, for example, a set of parametric runs that investigate the effect of varying relative 
firing rates among burners can now be easily accomplished for furnace constructions that 
contain a large number of user edits on top of the automatically generated grid. 
 
The “Protect Grid Edits” menu option can be unchecked to allow the user to unlock a 
protected grid. However, adding or moving one of the grid objects, such as a burner or 
exhaust, will require the grid to be reconstructed and any user hand edits will have to be 
reapplied. 
 
3.4.7 Automated Cycling Between Combustion and Melt Space 

Computations 
 
An automated control mechanism for cycling the simulation between the combustion and 
melt space without user intervention was added. This feature allows a tight coupling to be 
achieved between the combustion space and melt space computations. The melt 
computation uses the melt surface heat flux from the combustion space computation as its 
energy boundary condition at the melt surface. The combustion computation uses the 
melt surface temperature from the melt space computation as its energy boundary 
condition at the melt surface. The current estimate of the distribution of these values (heat 
flux or temperature) is exchanged between the combustion and melt space simulation 
programs at each half cycle transition. The cycling process is illustrated in Figure 6.  
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Automatic cycling includes the following enhancements to the GFM software package:  
 

• The combustion grids are copied to the melt case directory for use by the melt 
code to interpolate surface boundary coupling conditions between the combustion 
and melt domain grids. 

  
• The melt surface boundary condition files are automatically copied between the 

combustion and melt domain case directories as needed during cycling. 
 
• Information required to control automated domain cycling is maintained in the 

GUI and control program. Needed communication between the CFD codes and 
the control program has been added to provide a means to detect completion of a 
half cycle (i.e., the simulation run for one domain terminated normally with 
updated surface coupling conditions). When half cycle completion is detected, the 
control program executes the steps necessary to restart the simulation in the other 
domain (combustion or melt) with updated glass surface coupling conditions. 

 
• Four cycling submenu items were added under the simulation menu: cycling 

beginning with the combustion or melt domain first for a regular furnace and 
second for a regenerative furnace. 

 
• A new dialog box was added that allows cycle control parameters to be 

automatically changed after the first cycle is complete, with suitable defaults. 
 
• A new status box was added to the display screen to indicate the number of the 

current cycle, the active domain running, and the cycle status. 
 
• An option was added allowing the user to stop a cycle run after the current cycle 

has completed. This run termination saves all the files needed to restart the cycle 
and continue from the cycle where the termination occurred. 

 
 

Combustion Space 
Calculation with Radiation 

Heat Transfer 

Melt Surface  
Temperature 

Melt Surface 
 Heat Flux 

Melt Space Calculation 

1 Cycle ~ 1 to 6 hours 
Not 1 to 2 days 

Figure 6.  The cycling process 

 
 
 
 
 
 
 
 
 
 
 
 
In addition to greatly reducing the work and potential for user error in manual cycling, 
the greatest advantage in automated cycling is that the time required to complete a 
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coupled simulation for a moderately sized problem is reduced from about two weeks to 
about two days. Automated cycling works for both plain and regenerative furnace 
simulations. Initial experience has shown that 30 or more cycles are needed to obtain a 
reasonably well converged coupled solution. Completing such a large number of cycles 
manually is a tedious and time consuming task. Additional description and instructions 
for setting up automated cycling simulations are found in Appendix 5. 
 
3.4.8  Other Convenience, Performance, and Data Entry 

Enhancements in the User Interface 
 
In addition to the enhancements in the GFM user interface and control program described 
in the previous subsections, a large number of other user convenience, performance, and 
data entry enhancements have been implemented. The most significant of these are listed 
below. 
  
• Construction of exit tunnels of sufficient length to justify a convection dominated 

outlet flow assumption at melt exit boundaries was added to the automated grid 
generation scheme. This technique is often used in CFD computations to achieve 
stable convergence when recirculation zones may form near a system outlet 
boundary. In many typical melter geometries, recirculation zones do form near exit 
planes, and the exit tunnels are needed. Mesh refinement for exhausts and outlets in 
both the melt and combustion spaces was also added to improve resolution of the 
flow pattern near exits. The capability to specify parameters for these items was 
added to provide users the control needed to adjust parameters for difficult to 
converge cases. 

 
• For software developer convenience a capability to select release or debug mode 

when building executables was added. 
 
• GFM icons were created for use in the start menu, the Windows® taskbar quick 

launch area, the desktop, etc. 
 
• Mouse handles for moving and zooming the melter and furnace schematic figures 

were enlarged, and the mouse pointer now changes when the mouse is over the 
handle to indicate handle function, move or zoom. 

 
• The boundary layer thickness parameter in the model for heat conduction from 

molten glass to the batch layer on the surface was made user settable. 
 
• The capability to specify batch and cullet inlet velocity was added to the user 

interface. 
 
• The capability to specify temperature dependent batch and cullet specific heat, via 

user defined tables, was added. 
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• Options to specify separate emissivities for crown, walls, and melt surface were 
added to the user interface. 

 
• An option to enter burner flow rates and fuel heating value in either mass or volume 

based units was added to the user interface. 
 
• A new dialog box was added to the user interface that allows the user to enter, save, 

and edit a case description and case notes. 
 
• A new dialog box was added giving the user the option to abort a simulation 

immediately or to terminate before normal completion, but to delay until a point in 
the simulation is reached where data for restart can be saved. This option is similar to 
the one provided to terminate a cycle run at the end of the current cycle, except that it 
applies to terminating a combustion or melt space computation early (before the 
maximum number of iterations or convergence is reached) within a cycle. 

 
• The capability to activate the new RunPlot monitoring program from within the GUI 

was added. 
 
• New menu items are provided for the soot kinetic parameter calibration mode. A 

message is displayed on the screen indicating when the calibration mode is active. 
 
• The length and width of the main chamber was added to grid files so that CFD codes 

could reconcile any differences between the melt surface dimensions in the 
combustion and melt spaces. 

 
• A new dialog box was added to allow the user to specify what status, monitoring, and 

summary data to collect during simulations. 
 
• New help menu items were added that give the user access to several new documents 

covering both general and new specific features of the GFM software, such as how to 
setup and run automatic cycling simulations. 

 

3.5 General Enhancements to the Computational Fluid 
Dynamics Codes 

 
Some enhancements in the CFD codes are common to both the combustion space and the 
melt space, although their implementation is different in each space. These common CFD 
program changes are listed below. 
 
• A computer aided trouble shooting scheme was implemented with data collection and 

reduction to provide for a means for visual trouble shooting and monitoring the 
progress of a computation through graphs of mean global variables, such as mass 
mean temperature over the melt volume or mean exit temperature. The capability to 
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plot the residuals of the governing partial differential equations versus iteration is 
provided to allow the user to judge how well converged the solution is and to see the 
rate of progress toward an adequately converged result. 

 
• Status and trouble shooting data collection and reduction were implemented as 

optional computations so that the various types of data collection are only done when 
selectively specified by the user. 

 
• Communications between the CFD codes and the user interface and control program 

have been enhanced. More user control over the melt and combustion computations 
was provided via new communications between the GFM control program and the 
CFD codes as part of the basis for implementation of a cycle convergence control 
scheme. Timers were added in various CFD code sections to force periodic 
communication breaks with the GUI. 

 
• Automated cycling between the combustion and melt space computations in a 

coupled simulation was implemented to provide a major new capability that greatly 
reduces the time and work involved in obtaining the solution to a furnace simulation 
in which the combustion and melt space computations are coupled via conditions at 
the melt surface. 

 
• Most of the models and algorithms were upgraded to address robustness and 

numerical stability issues in both the combustion space and melt space components. 
The upgrades were implemented to improve the convergence levels that can be 
achieved in melt space and combustion space computations in order to make it 
possible to couple the solution in the two domains and achieve stable convergence in 
a computation that cycles between the melt and combustion space exchanging values 
of the coupling variables, temperature and heat flux, at the interface. 
 

• The new automatic cycling capability between the melt and combustion spaces was 
extended to handle regenerative furnaces. In regenerative cycling mode, a combustion 
space simulation is run for each of two regenerative burner firing patterns, the heat 
flux at the melt surface from these alternate firing patterns is then averaged and used 
as the heat source for the melt computation. The effects of relatively long periods of 
firing from one set of regenerative burners on batch distribution and melt flow and 
temperature distribution can still be investigated by running in normal cycling mode. 

 
• Simulation summary files were created that contain detailed information on global 

mass and energy balances. 
 
• The CFD codes were modified to use files located in case folders. 
 
• Relaxation factors that are used to stabilize numerical solution algorithms in 

nonlinear systems have been moved to a well commented text file where they can be 
modified by the user to aid in achieving reasonable convergence for problems that are 
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very sensitive numerically and do not converge well with the default values of these 
parameters. 

 

3.6 Combustion Space Model and CFD Code Enhancements 
 
On sample problems the combustion space CFD code of GFM Version 4.0 achieves 
global and local mass balances to between 3 and 4 significant figures (to within a fraction 
of a percent or better). Energy balances to about 3 significant figures have been achieved. 
The main combustion space CFD code changes in GFM are discussed in the following 
subsections. 
 
3.6.1 New Hybrid Radiation Solver  
 
A new hybrid radiation solver was designed and implemented that greatly improves the 
accuracy of the wall temperature and melt surface heat flux computation. While a direct 
solve of the Radiation Transport Equation (RTE) as implemented previously might be 
considered the best method because it involves minimal modeling, the discretization error 
in using this method with the limited memory and speed of a single personal computer is 
significant. Testing showed a very large error in wall temperature prediction for an 
idealized uniform heat flux case with a known solution. 

 
A new hybrid radiation solver was implemented that splits the direct solve of the RTE 
into two parts: (1) direct solve of RTE in the volume to get the heat flux from the flame 
(participating media) and (2) an enhanced wall radiation exchange in an enclosure 
computation. 

 
The new wall radiation exchange computation is much faster than the previous approach 
and more accurate by many orders of magnitude for the test problem with known 
solution. Because heat transfer to the melt is highly sensitive to wall temperature, this 
new two step radiation solver approach appears to have overcome a major difficulty in 
achieving adequately accurate wall temperatures. Figure 7 shows a schematic indicating 
the various heat fluxes that are included in the wall energy balance of the new hybrid wall 
radiation exchange algorithm. In the figure, qconv,i is the heat flux due to convection from 
the gas, qc,i is the radiation flux incident on a boundary patch originating from 
combustion in the volume via the participating media, qamb,i is the heat flux through the 
wall to the external surroundings, Hi is the radiation flux incident on a boundary patch 
originating from other boundary patches, ρ is the boundary patch reflectivity, ε is the 
boundary emissivity, and Bi is the radiation leaving a boundary patch (radiosity). 
 
This hybrid participating media and wall exchange thermal radiation computation works 
well in furnaces where emission from the media is much greater than absorption and the 
walls can be treated as opaque and gray. These conditions do prevail in a typical glass 
melting furnace. 
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New for wall 
exchange 

Figure 7.  Heat transfer balance at interior wall 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The radiation calculation was changed so that emission from the volume would be 
updated more frequently between full radiation calculations. Calculation of local 
radiation emission in the volume is a very efficient and fast process and provides 
reasonably accurate evolution of the radiation heat sink term in the gas phase energy 
equation when combined with the absorption terms computed in the previous full volume 
radiation computation. This change greatly reduces the magnitude of combustion space 
temperature and enthalpy perturbations after a full radiation calculation. 

 
As part of the radiation model upgrade, some user control over the wall exchange 
radiation computation was added. For example, if the user’s computer has sufficient 
memory, view factors computed from the grid geometry can be saved in memory to 
speed up the radiation wall exchange calculation, while if computer memory is limited, 
the user can set an option to recalculate view factors as needed during the computation. 
 
3.6.2  Automated Soot Model Calibration 
 
In air fuel furnace simulations, the radiation heat flux solution is very sensitive to soot 
production, distribution, and oxidation. To accommodate simulation with the resources of 
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a PC, a reduced two step soot production and oxidation model is used that has four 
kinetic parameters. In air fuel furnaces, the magnitude of the total heat flux to the melt is 
very sensitive to the kinetic model soot parameters, and these parameters may need 
adjusting for different types of burners, fuel, and furnace geometries. 

 
To provide a means to allow the user to set soot kinetic parameters for furnaces that are 
significantly different from those used for model validation, a new soot kinetic parameter 
calibration simulation mode has been implemented. The parameters can be calibrated 
using operating condition data from an existing furnace or design point conditions for a 
new design combined with an expected efficiency at the design point. In new designs, the 
calibrated soot parameters provide a reasonable baseline from which to test design 
variations to see whether performance improves or degrades with design parameter 
changes, such as burner position, size, or injection angle. 

 
When the soot kinetics calibration procedure is used, the derived soot kinetic parameter 
also implicitly accounts for some other unknowns or uncertainties in the models, such as 
air infiltration rates, variations in batch and other material properties, etc.  
 
The soot calibration can also be done for oxy-fuel furnaces, however, soot kinetics are 
not nearly as significant in oxy-fuel furnaces because a large fraction of the radiation heat 
flux comes from the dominant combustion products, carbon dioxide and water vapor. 
More detailed information on the soot calibration procedure can be found in Appendix 1. 
 
3.6.3  Other Enhancements in the Combustion Space Model 
 
Many other enhancements to the combustion space model were implemented in GFM 4.0 
to improve accuracy, numerical stability, and convergence of the simulations. The most 
significant of these enhancements are described in the following list. 
 
• Special attention was paid to obtaining good energy equation convergence each time 

the energy equation is solved in the global iteration scheme. This improvement 
appears to have helped in achieving more rapid convergence and greatly improved 
final results for all of the governing equations in the simulation. 

 
• The high level combustion space algorithm was revamped to speed up the 

computation. Major inefficiencies in the global combustion space solver organization 
were identified and the algorithm was redesigned, achieving a speed up by a factor 
between 2 and 5. This speed up makes automatic cycling convergence within a target 
of 24 to 48 hours much more feasible. While this efficiency gain may lead to shorter 
run times, it may also allow running with more refined grids to better resolve flow 
features to obtain acceptable accuracy. 

 
• The convergence of the solution of transport equations for minor species and soot, 

which determines the volume radiation source distribution, was optimized by 
adjusting relaxation factors and the number of solver sweeps per global iteration. 
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• A relaxation algorithm for the temperature distribution passed as the surface boundary 
condition from the melt space computation to the combustion space computation in 
automated coupled cycling was implemented. This change was needed to damp wild 
temperature oscillations when cycling toward coupled melt and combustion space 
convergence. A similar relaxation algorithm was implemented for the melt surface 
heat flux distribution passed from the combustion space to the melt space 
computations. 

 
• The restart algorithm was fixed so that solution precision is retained during restart. 
 
• An energy equation wall function was added to the turbulence models to obtain a 

value for wall heat flux in regions of high turbulence. Convective wall heat flux is 
now computed using the turbulence model wall function in combination with the 
previous user specified heat transfer coefficient, depending on turbulence intensity in 
the vicinity of the wall. This wall function is used with the energy equation to 
enhance the model accounting for the convective contribution of heat transfer to walls 
and the melt surface. 

 
• New routines to compute gas mixture enthalpy and to compute gas temperature from 

enthalpy were written using National Institute of Standards and Technology (NIST) 
rational functions for the enthalpy of a mixture species and a Newton solver to obtain 
temperature from enthalpy with an accuracy near machine precision. The new 
algorithm to compute mixture temperature from enthalpy replaced previous table 
based gas mixture enthalpy-temperature routines, which were accurate only to a few 
percent.  

 
• The use of separate emissivities for walls, crown, and melt surface was implemented. 
 
• The status output to the command prompt window was redesigned to make it more 

meaningful. 

3.7 Melt Model and CFD Code Enhancements 
 
The original melt model in the version 2.0 CFD code simply did not converge well and 
did not yield reasonable results unless the initial guess was close to a reasonable result 
and specific constraints were hard coded. Many problems had to be fixed to substantially 
improve this situation. 
 
Major improvements were made to the batch heat transfer and melting model. These 
improvements were necessary to achieve a good accounting of energy transferred directly 
to the batch from the combustion space and indirectly from molten glass back to the 
batch. The algorithm for calculating the distribution of surface radiation to batch, cullet, 
and molten glass was corrected and improved. An improved model for handling the tip or 
end of the batch was added for numerical stability. 
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3.7.1 Melt Surface Heat Flux from Combustion Space 
Computation 

 
The heat flux at the melt surface is computed in the combustion space computation. It 
determines the total energy entering the melt and its distribution over the surface. This 
heat flux distribution must be interpolated from the combustion space grid points to the 
melt space grid points at their shared interface. New routines were written to interpolate 
temperature and heat flux between the melt and combustion space grids at the interface 
between spaces. Testing of the old routines revealed significant errors primarily in the 
corners. Figure 8 and Figure 9 show results of interpolation using the new interpolation 
algorithm. The example results in  clearly reveal another source of error in 
coupled solutions of the melt and combustion space that users should be aware of. Batch 
chargers are well resolved in the melt grid but not in the combustion grid in Figure 9.   
When cell sizes vary significantly at the melt surface when comparing the melt grid to the 
combustion grid, temperature and heat flux distributions may not be well resolved when 
transferring melt surface energy boundary conditions between the melt and combustion 
spaces. The heat flux interpolation does preserve the total energy transfer from 
combustion space to melt in doing the interpolation, and the temperature interpolation 
does preserve the area mean temperature over the melt surface. 

Figure 9

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8.   Reasonably well resolved heat flux interpolation between coarse grids 
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 Figure 9.  Loss of resolution in temperature distribution due to coarse combustion 

space grid  
 
A scheme for handling melt surface dimensions that do not match exactly between the 
two domains, combustion and melt, was implemented. This situation might arise if 
furnace schematics show slightly different dimensions for melt and combustion spaces. 
The existence of small shelves or overhangs is not accounted for in the current model. 
The model assumes that the melt surface is a rectangle with the primary dimensions of 
the melt or combustion spaces. If these are slightly different, the interpolation of 
temperature or heat flux between combustion and melt grids assumes that the grids match 
at the center. The interpolation then scales the heat flux to preserve the total heat transfer 
from combustion space to melt and scales the temperature to preserve the area mean 
temperature.  

 
Refiners and dog houses (sidewells) are handled by excluding them from the surface 
coupling condition computations. The model assumes that the melt surface in a refiner is 
adiabatic (heat lost from the surface is negligible). The effects of dog houses in the 
combustion space on the flow pattern are accounted for in computing the hydrodynamics, 
but the net effect of radiation heat transfer from dog houses is assumed to be negligible. 
Surfaces in dog houses are included in the wall radiation exchange computation, but 
shading of walls by intervening surfaces is not accounted for. 
 
A constraint requiring a positive heat flux into the melt at every point over the entire melt 
surface was removed. This change yielded a pattern of oscillatory instability in cycling 
boundary conditions between melt and combustion space computations. The instability 
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problem was resolved by relaxing the coupling conditions between the melt and 
combustion space. 
 
An option to scale surface heat flux into the melt was implemented. This option allows 
the user to specify an outlet boundary melt temperature and scale a uniform or calculated 
surface heat flux to meet energy needs for the outlet boundary temperature. This feature 
is needed to provide stability during the early cycles of a fully coupled melt and 
combustion space simulation. Normally the first eight to sixteen cycles of a coupled 
simulation should be run with scaling on to bring the combustion space crown and wall 
temperature and the melt temperature and velocity fields close enough to the solution for 
the simulation to reach stable convergence over the next 30 to 50 un-scaled cycles. 
 
The melt surface heat flux scaling may also be useful for users on a standalone basis. 
Based on the batch inlet flow rates and material properties, the energy needed to heat the 
batch up to the melting point, to melt the batch, to heat the melted batch up to the outlet 
temperature, and to account for losses through walls is computed. The surface heat flux 
distribution is then scaled in this mode to provide the needed amount of energy. This 
scaling is repeated through the solution process to account for changing energy losses 
through the walls as the flow pattern in the melt develops. Scaling can be used to produce 
a reasonable melt solution for a particular charging rate when the energy entering the 
melt from the combustion space is either too high or too low. Results output from the 
scaled melt solution indicate how much adjustment is required in operating conditions, 
such as burner firing rates, in the combustion space to yield the desired charging rates and 
melt outlet temperatures. 
 
3.7.2 Flow Boundary Conditions in the Melt 
 
Free surface boundary conditions at the melt surface were improved. Pressure at the 
surface is taken to be the reference pressure which should be set to the pressure in the 
combustion space. This can be any reasonable mean pressure, often atmospheric pressure. 
In the momentum equations, free slip boundary conditions are applied to areas of the 
surface not covered by batch. Recognize that batch in often pushed into the furnace and 
that melting at the interface between batch and melt can cause the batch to form a shelf at 
the melt surface. When the batch layer is thick, it is treated as a moving wall to obtain 
momentum boundary conditions in the melt at the melt-batch interface. As the batch layer 
thins out it will break up and no longer exert a shear generated force on the melt. The 
batch model does not have sufficient detail to resolve batch layer breakup, however, a 
transition function is applied to the surface shear calculation between melt and batch to 
change smoothly from a moving wall condition to a zero shear condition as the batch 
layer thins out and melts completely. 
 
Outflow boundary conditions were changed to a known velocity condition based on the 
user specified pull rate split between multiple exits when multiple exits exist. The outlet 
boundary conditions were previously free flow conditions, which in many cases caused 
over prediction of the outflow mass flow rate by a factor of two or more. The new 
outflow boundary conditions in combination with the automatically generated extended 
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exit tunnels in the grid yield solutions in test cases that balance mass entering and leaving 
the melter to nearly four significant figures. The addition of exit tunnels in the grid 
eliminated the numerical difficulties caused when a recirculation zone in the bulk flow 
occurs near an exit.  shows an example of a melt space grid with an exit tunnel 
of sufficient length for outflow boundary conditions to be valid. 

Figure 10

 
 
 
 
 
 
 

Figure 10.   Melt space figure and grid view with exit tunnel 

 

This melt space figure view 
highlights the refiner. The grid 
view shows the entire melt 
space. 

           melter                          throat   refiner   exit tunnel 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.7.3 Other Enhancements in the Melt Model 
 
The melt code was converted from a non-dimensional to a dimensional code internally to 
allow for relatively easy checking of dimensional consistency. A dimensional consistency 
check was performed and some minor problems were corrected. 
 
Calculation and output of the mean residuals of the governing partial differential equation 
(PDE) for the melt was implemented. These residuals can be plotted versus the iteration 
number using the RunPlot utility program to observe progress toward a converged 
solution for the various equations that are solved (mass, momentum, and energy 
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transport). The residuals are normalized so that the log of the residual indicates the 
approximate number of significant digits in the solution. 
 
The PDE solver relaxation factors were adjusted to improve convergence (lower 
residuals) while maintaining computational efficiency. These relaxation factors were also 
made available for user adjustment for cases in which good convergence is difficult to 
obtain. Appendix 1 contains a discussion of which of these parameters to adjust and how 
to adjust them in difficult cases based on trends in equation residuals that can be plotted 
via the RunPlot utility provided with GFM. 
 
Temperature dependent cullet and batch specific heats were implemented using a table of 
user defined values passed in a file from the user interface and control program. 
 

3.8 RunPlot Simulation Progress Plotting Program 
 
To facilitate rapid isolation of problems, a substantial amount of data collection on the 
state of the computation was implemented in both the melt and combustion space CFD 
codes. To quickly view and analyze this data, a new tool, RunPlot, was written. This 
status monitoring program provides for on screen plotting of status and progress variables 
during the course of a simulation. RunPlot makes it easy to see how a simulation is 
progressing and when temperatures and heat transfer rates have stabilized indicating that 
the simulation is done. RunPlot also makes it easy to spot problems in a simulation and 
take steps to correct them. Refer to Appendix 6. 
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 Figure 11.  Melt domain sample RunPlots 



Examples of status monitoring variables are residuals from the governing mass, 
momentum, and energy conservation equations, average temperatures, combustion space 
energy release and distribution (to melt, to exhausts, loss through walls, etc.), energy 
distribution and balance within the melt (energy transfer to solids, liquid, walls, etc.). 
Examples of several of these plots are shown in Figure 11 and Figure 12. 
 
 

Figure 12.  Combustion domain sample RunPlots 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In addition to being a powerful tool for GFM developers to trouble shoot problems, 
RunPlot is also a very useful tool for GFM users. Using the RunPlot program to monitor 
simulation status provides a visualization of simulation progress and current state of the 
solution that is much easier to assess than trying to determine from numeric summary 
data displayed in user interface windows if the solution state is physically realistic and 
progress toward a solution is reasonable. Features included in the RunPlot program to 
increase its utility for GFM users include the following: 
 
• Display options allow font size to be changed, the number of ordinate axis labels to 

be increased or decreased, the background color to be toggled for screen prints, and a 
new file to be opened. These options are available through the keyboard shortcuts and 
a right click mouse button menu. 

• A color coded legend in a separate window was included to identify the colored plot 
lines. The legend can be closed and toggled back on. 
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• RunPlot can be used to display the history of progress and state of a simulation after 
the CFD computation has terminated. This capability provides a quick way to visually 
review trends in the status and state data without the work of importing the data files 
into a spreadsheet program that has plotting capabilities.  

 

3.9 Documentation 
 
New GFM documentation is available from the Help item on the GFM menu bar. This 
documentation is provided in PDF format. The user must, independently of GFM, have a 
viewer (such as Adobe’s Acrobat Reader) installed to display the documentation files. 
These files are also installed in a document folder in the GFM directory tree. They can be 
opened and read on the computer or printed and read at the user’s convenience. 
 
The document folder installed with GFM contains the following documents: 
 

• GFM 4.0 Tips and Special Procedures 
The GFM 4.0 Tips and Special Procedures document provides a variety of useful 
information for using GFM. It also contains a discussion of the soot model 
calibration procedure and instructions for carrying it out. For cases that fail to 
converge to a stable steady state solution, a procedure for identifying solver 
parameters to adjust and how to adjust them is explained. 
 

• GFM 4.0 Graphical User Interface Menus 
The GFM 4.0 Graphical User Interface Menus document contains tables with 
brief notes that map out the menu system in the GFM user interface in one place. 
 

• Using the GFM 4.0 Graphical User Interface to Build, Run, and Review Models: 
Two Examples 
An example of how to build a furnace model with step by step instructions for 
navigating the menu system to accomplish the data entry tasks is contained in the 
document Using the GFM 4.0 Graphical User Interface to Build, Run, and 
Review Models: Two Examples. This document also contains instructions for 
creating a new simulation case from an existing case with different run 
parameters. The procedure allows users to easily build and run a parametric series 
of simulations over an operating parameter of interest, such as burner firing rates. 

 
• GFM 4.0 Files 

GFM 4.0 Files contains a discussion of the different file types that are generated 
during the construction and simulation of a furnace model and a set of tables 
listing the files by category with a note indicating file contents. Because file 
handling is automated in GFM 4.0 and the user works with cases, very little 
information on the files generated by GFM is needed by users. However, Tables 2 
and 5 are useful. They list the files in the combustion space and melt space 
respectively that contain simulation monitoring data that can be plotted with the 
RunPlot program. 
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• GFM 4.0 Automated Cycling Guide 
A detailed discussion of the simulation cycling capability and procedures for 
setting up and starting cycling runs in found in GFM 4.0 Automated Cycling 
Guide. 
 

• GFM 4.0 RunPlot User’s Guide 
The GFM 4.0 RunPlot User’s Guide provides an overview of the status 
monitoring program provided with GFM. 

 
• GFM Copyright Notification 
 
• Glass Furnace Model (GFM) Software License Agreement 
 
• Glass Furnace Model (GFM) Development and Technology Transfer Program 

Final Report (this document) 
The Glass Furnace Model (GFM) Development and Technology Transfer 
Program Final Report document provides GFM project background information 
and detailed lists of the enhancements in GFM 4.0 with discussion of the major 
new features. 
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4 International Commission on Glass Technical 
Committee 21 Test Case 

4.1 Test Case Included in GFM 4.0 Software Package 
 
A solved sample test problem is included in the GFM 4.0 release. This test problem 
simulates hypothetical 20 ton/day and 40 ton/day regenerative glass melting furnaces 
coupled to the glass melt. The sample problem definition is taken from the round robin 
test conditions specified by Technical Committee 21 (TC21) of the International 
Commission on Glass (IGC). The purpose of the TC21 committee is to share and 
exchange current information on efforts to model the processes in glass furnaces and to 
promote the development of the theory and application of mathematical modeling of 
glass furnaces. The GFM 4.0 sample problem is based on round robin tests 4 and 4a of 
the TC21 committee. The specifications for these tests are in Appendix 7.  These test 
cases were chosen as the base cases for testing upgrades in GFM 4.0 because the 
geometry is simple, allowing tests to be run in a little more than a day, and because 
results can be compared with those of other glass modelers from around the world who 
are members of the TC21 committee of the IGC.  Funding was not available for more 
extensive testing. 
 

4.2 Test Case Results and Discussion 
 
The convergence monitoring plots for the 40 ton/day case are shown in Figure 11 and 

 of Section 3.8. The spikes in these plots generally occur when the melt surface 
boundary conditions are perturbed in cycling between the combustion space and melt 
space computations. While many of the plotted values settle down to their final range of 
values fairly quickly, the cycling is continued until the heat flux and temperature 
distribution boundary conditions exchanged between melt and combustion space 
computations are stable to about three significant figures. The simulation is also 
continued until the volume mean melt temperature and area mean melt exit temperatures 
have reached stable asymptotic values. They are just reaching asymptotic values in the 
plot in the lower left corner of Figure 11. These conditions were reached after about 60 
cycles between the melt and combustion spaces. 

Figure 12

 
4.2.1 Visualization of Test Results 
 
Examples of visualization of results that can be obtained with the post processor provided 
in GFM 4 are shown in this section.  Color density plots of the combustion space 
temperature with velocity vectors are shown in Figure 13. The z-x plane is cut vertically 
through the burner at one of the fuel ports. It shows the penetration of the jet flame into 
the furnace and the recirculation zone that forms above the flame.  The y-x plane is a 
horizontal slice through the fuel inlet ports of the burner.  It shows penetration of the jet 
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flame into the furnace at the height of the slice. The fuel jet is directed eight degrees 
upward, and consequently the maximum penetration of the flame is in a plane above the 
fuel inlet ports. Color density plots of the melt space batch coverage are shown in 

. The batch coverage is about 1/3 of the furnace surface. This batch coverage was 
computed from a mean heat flux obtained from averaging the left and right side burner 
firing conditions.  This approach assumes that the melt responds slowly to changes in 
conditions in the combustion space above.  In reality, batch length on the surface will be 
less on the side with the active burner near the end of that burner’s firing period.  

Figure 
14

 
 
 

Figure 13. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Temperature distribution and flow pattern in the fuel injector planes 

Figure 14. Batch coverage computed from the mean of left and right s
firing modes 
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Plots of the temperature distribution and flow pattern in the melt in selected planes near 
the surface and through the center of the exit throat are shown in .  The average 
heat flux from the two burner firing configurations was also used in the melt simulation 
to obtain this result. As a consequence, the pattern is nearly symmetric across the 
centerline. 

Figure 15

 
 
 

Figure 15. Melt temperature distribution with flow pattern near the surface and 
through the exit throat 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.2.2 Test Result Summary Data 

 
Summary data files are produced for both the combustion and melt spaces. The data in 
these files include a variety of values obtained by integrating over boundaries or the 
volume of the domain. Examples are inlet flow conditions (how much mass and energy is 
coming in with the flow), energy requirements for the melt based on the solids inflow 
rate, material properties, and a user specified outlet mean glass temperature, and where 
the energy ends up, such as how much goes out the exhausts, goes into the melt, is lost 
through walls, etc.. 
 
Figure 16 contains the summary data for the combustion space for right side firing of the 
burners.  The top section gives the mass flow rates through the burners along with the 
heating value of the incoming fuel.  These numbers are followed by two ways of doing an 
energy balance: one on the gas in the combustion space and one on the combustion space 
including the walls.  The energy balance on the gas is accurate to about 3 significant 
figures and on the furnace including the walls and others surfaces to about 3 percent.  The 
details of the energy balances provide useful information on where the energy coming in 
with the flow and released in the combustion ends up.  For example, in this test problem 
about 60% of the energy coming in goes out through the exhaust with the combustion 
product gas, about 3.6% is lost through the walls and crown and approximately another 
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3% is lost via net radiation heat transfer through exhaust and burner openings.  About 
33% of the energy is transferred to the melt.  Nearly all of the energy transferred to the 
melt is radiation heat transfer from interior surfaces; only about 6% is direct radiation 
from the flame and less than 1% is due to convection from the hot gas above the melt 
surface.  About 3% of the incoming energy is transferred to walls via convection, which 
raises the wall temperature and contributes indirectly to the radiation heat transfer from 
surfaces to the melt.  This type of order of magnitude information can be used to identify 
the parts of the process where investment in analysis and consequent changes in furnace 
design or operating conditions have the greatest potential of achieving significant gains in 
energy efficiency. 
 
An example of summary data for the melt space simulation is shown in Figure 17.  The 
top section gives the boundary data for the melt surface and inlets (chargers).  Based on 
the batch and cullet solids in flow rate, the material properties, and a user specified mean 
glass exit temperature, the energy required to heat up, melt the solids, and then heat up 
the molten glass to the mean outlet temperature is listed.  The sum of these values is an 
estimated adiabatic energy requirement for the melt (the energy rate required not 
considering wall losses that are computed in the simulation).  In the example shown in 

 this value is about 1.03 MW. Figure 17

Figure 17

 
In the full summary file, data on the various energy transfer rates for the melt space and 
mass balances are given at the end of each cycle.  The last set of such data at the end of a 
set of cycles is shown in  under the header “Run End.” 
 
In the section of the run summary data under “Run End” the following information is 
provided.  The net energy coming in to the melt through the melt surface via radiation 
and convection and electric boost is listed.  The next block in this section lists the energy 
requirements for the incoming solids to heat them to the melting point and then to melt 
them.  Energy transferred to the solids is listed.  This energy comes from two sources, 
direct heat transfer from the combustion space via radiation and convection and energy 
transferred by conduction from the molten glass below the solids on the surface, in the 
case shown this value is about 0.86 MW.  Energy transferred from the molten glass to the 
solids to heat and melt them from below must enter the system through areas of the melt 
surface not covered by batch or from electric boosters (not present in this case).  The 
summary data lists both the total energy needed to heat and melt the batch and the net 
energy transferred to the batch from the combustion space above and the molten glass 
below. 
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# Case 0040 Summary Data for Simulation and Evolving Global Energy 
Distribution 
 
#   Number of cells in combustion grid:   4377 
#   Melt surface area:                    0.21000000000000E+02 m^2 
 
#   Fuel in flow rate:                    0.39762878083587E-01 kg/s 
#   Oxygen in flow rate:                  0.17547777964822E+00 kg/s 
#   Nitrogen in flow rate:                0.57791249651488E+00 kg/s 
#   Total in flow rate:                   0.79315315424668E+00 kg/s 
 
#   Heat value in with fuel:              0.19881439041793E+07 W 
 
# #################   Run End   ################# 
 
# Energy Balance on Exterior Walls 
# -------------------------------- 
 
#   Total energy in:                    0.31194147751189E+07 W 
#       Energy in with flow:                0.12138062448321E+07 W 
#       Energy in via combustion:           0.19056085302868E+07 W 
 
#   Total energy leaving furnace:       0.32324909367981E+07 W 
#       Energy out with flow:               0.19415082875191E+07 W 
#       Energy out through walls:           0.11512325088072E+06 W 
#       Net radiation out inlets:           0.53023501285162E+05 W 
#       Net radiation out outlets:          0.43845615784386E+05 W 
#       Energy out to melt:                 0.10789902813288E+07 W 
#           from flame:                         0.69858445806380E+05 W 
#           from surfaces:                      0.10073147307997E+07 W 
#           from convection:                    0.18171047226586E+04 W 
 
# Gas Energy Balance 
# -------------------------------- 
 
#   Total energy in:                    0.31194147751189E+07 W 
#       Energy in with flow:                0.12138062448321E+07 W 
#       Energy in via combustion:           0.19056085302868E+07 W 
 
#   Energy out with or from the gas     0.31410604666860E+07 W 
#       Energy out with flow                0.19415082875191E+07 W 
#       Convection to walls                 0.98690935007754E+05 W 
#       Convection to melt surface          0.18171047226586E+04 W 
#       Radiation from flame to melt:       0.38234011234061E+06 W 
#       Radiation from flame to walls:      0.69503424954264E+06 W 
#       Radiation from flame to inlets:     0.98159536449222E+04 W 
#       Radiation from flame to exits:      0.11853823908353E+05 W 
 
# -------------------------------- 
 
#   Mass in:                            0.79273500724714E+00 kg/s 
#   Mass out:                           0.79273067980525E+00 kg/s 
 
#   Fuel mass out:                      0.19549812479519E-02 kg/s 
#   Fuel energy out:                    0.97749062397594E+05 W 
 
#   Mean temperature:                   0.17651095783624E+04 K 
#   Mean exit temperature:              0.18208686791114E+04 K 
#   Mean wall temperature:              0.16301531064894E+04 K 

Figure 16. Summary data from last cycle of 40 TPD RRT4 combustion space simulation 
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# Case 0040 Summary Data for Simulation and Evolving Global Energy 
 Distribution 
 
#   Number of cells in melt grid:       2780 
#   Melt surface area:                  0.21000000000000E+02 m^2 
 
#   Specified exit temperature T_ex     0.15500000000000E+04 W 
#   Estimated wall loss at T_exit:      0.56094396111112E+05 W 
#   Mean Surface Heat Flux:             0.47619047619048E+05 W/m^2 
 
#   In-Flows: 
 
#   Batch:                              0.46296290446212E+00 kg/s 
 
#   Heat Inputs and Requirements: 
 
#   Radiation + Convection:             0.10000000000000E+07 W 
#   Alternate Burners Rad + Conv:       0.10000000000000E+07 W 
#   Electric Boost:                     0.00000000000000E+00 W 
#   Total Energy In:                    0.10000000000000E+07 W 
 
#   Batch heatup:                       0.50483368635668E+06 W 
#   Batch melt:                         0.34722217834659E+06 W 
#   Batch q needed:                     0.85205586470327E+06 W 
 
#   Liquid heatup need:                 0.16433877315598E+06 W 
#   Adiabatic energy need:              0.10163946378592E+07 W 
 
# #################   Run End   ################# 
 
#  Heat Values at Run End: 
 
#   Radiation + Convection:             0.10763815173279E+07 W 
#   Electric Boost:                     0.00000000000000E+00 W 
#   Total Energy In:                    0.10763815173279E+07 W 
 
#   Batch heatup need:                  0.50483368635668E+06 W 
#   Batch melt need:                    0.34722217834659E+06 W 
#   Radiation to Batch:                 0.67810159011925E+06 W 
#   Conduction to Batch:                0.18302800210705E+06 W 
#   Batch q needed:                     0.85205586470327E+06 W 
#   Batch q net:                        0.86112959222631E+06 W 
 
#   Liquid heatup need:                 0.16433877315598E+06 W 
#   Liquid q net:                       0.15970375204391E+06 W 
#   Adiabatic energy need:              0.10163946378592E+07 W 
#   Wall heat loss:                     0.55548173057651E+05 W 
#   Net melt input energy need:         0.10719428109169E+07 W 
#   Actual melt input energy:           0.10763815173279E+07 W 
 
#   Energy need divided by input:       0.99587627031910E+00 
 
#   Mean glass exit temperature:        0.15423242163494E+04 K 
#   Batch rate in:                      0.46296290446212E+00 kg/s 
#   Melt rate:                          0.46296290446357E+00 kg/s 
#   Glass rate out:                     0.46296311924483E+00 kg/s 

17. Summary data from last cycle of 40 TPD RRT4 melt space simulation 
 
Figure 
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The third block of melt summary data at run end lists energy needed to heat the molten 
glass from the melting point temperature to a user specified mean molten glass outlet 
temperature, computed wall heat loss, and total energy needed by the melt compared to 
actual energy entering the melt through the surface from the combustion space and 
electric boosters if present. The ratio of the energy needed by the melt, including wall 
losses, to incoming energy is listed.  Changes in the combustion space geometry or 
operating parameters that improve furnace efficiency will increase the melt outlet 
temperature because more of the combustion energy is transferred to the melt. The firing 
rate of burners in the combustion space will need to be decreased to bring the melt energy 
need versus energy input back into balance, which provides an estimate of fuel savings 
that could be obtained from an improvement in the design or operating conditions. 
 
The last block of data in the melt summary data at run end lists the computed mean glass 
exit temperature and the total mass rates, which can be compared for balance.  These 
include the total rate of solids coming in, the melting rate, and mass rate of molten glass 
leaving the system.  In Figure 17 these values are about 0.46 kg/s and they match to about 
five significant figures. 
 
To conclude, the summary data can be used both to check the simulation to verify that the 
various energy and mass transfers in the system all balance and to understand how the 
melt is operating in terms of the relative size of the various energy transfers. 
 
4.2.3 Reporting of Test Results to the IGC TC21 Committee 
 
The TC21 committee specifications for RRT4 and RRT4a tests have been evolving over 
time as models improve and fewer simplifying assumptions are needed to bring the 
hypothetical furnaces of the specification closer to a real furnace.  Results of the current 
TC21 problem computations were reported and discussed at the TC21 committee meeting 
at the ICG International Congress on Glass in Strasbourg, France, 2007.  Flow patterns, 
temperature distributions, batch coverage, and other results from the test problem are 
within the range of those obtained by other modelers running the test problem.  A few 
final changes to the RRT4 and RRT4a specifications have been made by the committee.  
A member of the committee, who has been beta testing GFM Version 4.0, is planning to 
obtain a final set of results for the RRT4 and RRT4a tests with the latest parameter 
changes and submit them to the committee for comparison with other models.  A report 
from the TC21 committee giving results of this comparison is expected in the future. 
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5  Availability of the Glass Furnace Model Version 4.0 
at Project Completion 

 
Version 4.0 of the Glass Furnace Model with the extensive enhancements and model 
upgrades described in Section 3 and the Appendices has been released. GFM Version 4.0 
can be ordered via Argonne’s Office of Technology Transfer Software Shop web site. It 
is currently offered for license on the commercial side of the Software Shop. A 
description and license information can be viewed at:  
 
http://www.anl.gov/techtransfer/Software_Shop/GFMSoftware/GFM_Software.html  
 
GFM is currently offered with an initial free six month trial license. License fees for the 
commercial license after the trial period have been reduced to $3,000 for a U.S. company 
and $6,000 for a foreign company, respectively, for a single copy of the software 
package. A university/non-profit license is also offered at $500 for a U.S. university and 
$700 for a foreign university. 
 
The Glass Furnace Model software version 4.0 is copyrighted, ANL-SF-01-030c. 
 
An Argonne technical contact is available for limited questions regarding use and 
installation of the GFM software. However, because funding for continuing development 
and support of the software is no longer available, extensive technical support or changes 
to the software must be arranged for on a cost recovery basis. The technical contact for 
GFM is: 
 

Steven A. Lottes, Ph.D. 
Energy Systems Division 
Argonne National Laboratory 
9700 South Cass Ave. 
Argonne, IL     60439-4815 
 
Phone: (630) 252-7014 
Fax:    (630) 252-1342 
SLottes@ANL.gov 
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The contact in Argonne’s Office of Technology Transfer for licensing information is: 
 

Paul Betten 
Software Licensing Coordinator 
Office of Technology Transfer-201 
Argonne National Laboratory 
9700 S. Cass Ave. 
Argonne, IL 60439 
Phone: (630) 252-4962  
betten@anl.gov 
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Appendix 1 
GFM 4.0 Tips and Special Procedures  

 
The information in this document is provided on diverse topics to help users effectively 
apply the Glass Furnace Model and resolve or avoid problems when using it. It includes 
procedures for calibrating the soot model and manually adjusting relaxation factors to 
improve simulation convergence or achieve convergence for numerically difficult 
problems. 
 
1.  Tips and Things to Know about GFM 
 
Known Problems with Work-Arounds 
 

• Case folders will not be automatically deleted. The Delete Case menu item will 
delete all the files in the case folder. However, an unresolved problem in 
Windows prevents the case folders from being deleted. GFM must be exited 
before a case folder can be manually deleted. 

 
• The simulation run status displayed in the green boxes is now very limited. Some 

of the variables that were displayed before are no longer used or may have 
changed due to the major upgrades that have been done to the CFD code, 
especially for radiation. This interface with the GUI has not been reworked. The 
new RunPlot program is an excellent tool that can be used to monitor the 
simulation progress. The command prompt window also provides simulation 
progress information. 

 
General Information 
 

• Case folders and files must be in the proper directories. 
 

• Case folders and files must be named properly.  Renaming case folders using long 
file names with keywords can make saved cases easy to identify, however, to 
reprocess those cases in GFM, the case folders must be renamed with their 
original name. 

 
• Files should not be modified manually. (An exception exists for the 

relaxfactor[m/c].txt files as explained below in the Adjust Relaxation Factors 
Procedure.) 

 
• Some actions cause the furnace figure or grid plot to be moved or resized. Use the 

green box diagram handles to resize or reposition the diagram. The lower left 
corner handle is for moving the diagram. The upper right corner (where the 3 grid 
slices meet) handle is for resizing. 
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• Sometimes a new burner cannot be added to the furnace. Adding or deleting an 
object from a constructed furnace will cause the grid to be reconstructed and then 
previous enhanced grid edits would be lost. Therefore, when an enhanced grid 
edit is made, the Protect Grid Edits option is automatically checked and objects 
will not be allowed to be changed. The Protect Grid Edits option can be turned 
off when the user really wants to modify the grid. 

 
• The open file dialog box in RunPlot usually comes up in the directory of last use 

(as opposed to the one of the current case). The user may navigate to the directory 
of the file to open. 

 
• Multiple instances of RunPlot may be run, and the RunPlot windows can be 

moved and resized to easily monitor the status of variables from different data 
files simultaneously. 

 
Combustion Domain 
 

• Air is assumed to be composed of nitrogen and oxygen only. 
 
• Radiation must be turned on in the combustion space for cycling runs. In general, 

heat transfer under furnace operating conditions is dominated by radiation heat 
transfer.  Therefore, although combustion simulations can be run without the 
radiation heat transfer computation included, the gas temperatures will likely be 
unrealistically high because heat loss from radiation has not been accounted for. 

 
• The number of iterations in a combustion run may exceed the user specified 

value. Ten extra gas phase iterations will be added after a full radiation 
calculation has been done, even if the user set iteration count has been exceeded, 
so that the radiation information gets propagated into the gas flow field. 

 
Melt Domain 
 

• In order to resolve the flow field at melter outlets, the grid will show a thick wall 
and exit tunnels. For the purposes of estimating heat losses through walls, the wall 
thickness specified by the user is used for all walls regardless of how they have 
been modified in the grid generation process. 

 
• Melter outlet tunnel information (in the green boxes) applies to all the melter 

outlets. This information cannot be changed for individual outlets. 
 

• Melter outlet pull rate fractions are automatically changed when an outlet is added 
or deleted. The user can change the pull rate fraction values individually. 
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Simulation 
 

• Convergence is determined by looking at the convgnnnn[m/c].plt file via the 
RunPlot program. The graph will show the normalized mean and maximum mass 
residual as a logarithmic plot in either the melt [m] or combustion [c] domains. 
Considering a computational cell as a control volume, the absolute value of the 
log of the normalized mean mass residual indicates how many significant digits of 
mass balance have been achieved in the computational cells averaged over the 
entire grid. When the simulation has converged, the mean residual line should be 
at a level of -3 or less, although in difficult to converge cases, some useful 
information may be obtained when the mean mass residual is below -2.  When the 
mass residual plot has gone asymptotic, further iteration is not likely to 
significantly improve convergence in terms of mass balance.  However, other 
significant physical characteristics of the system, such as the mean temperature 
may still be evolving. Iteration should be continued until all major measures of 
system state have stabilized. 

 
• Certain variables are extremely sensitive to various conditions that may cause the 

temperature to go way beyond a realistic value or prohibit the simulation from 
converging. When such a situation occurs, stop the run and do the following: 

o Look at the grid to be sure that it has been constructed properly. Make 
sure the inlets and exits are properly located and sized. 

o Carefully review all the properties, parameters, conditions, and options 
that can be set in the pre-processor to make sure that they are realistic and 
agree with the furnace design. Doing an approximate heat balance for the 
furnace operating conditions can be very useful in identifying unrealistic 
parameter values. 

o Examine the flow patterns within the furnace by entering the post 
processor and clicking on “vectors” in the grid control block. Change 
positions in the grid and reclick “vectors” as needed to get a good idea of 
what the flow pattern is. Perhaps better resolution is needed near various 
objects to improve the flow. In that situation, create a new case with a 
refined grid that is denser near those objects. 

o Use the Soot Model Calibration Procedure given below. 
o Use the Adjust Relaxation Procedure given below. 

 
• If the simulation display updates have been turned off during a run, then the old 

information that is not current will remain on the screen even after the run is done. 
 

• There is more than one way to tell if a simulation is running. 
 

1. There may be a long delay between GUI display updates to the status 
boxes in the main GFM application window, especially when there are 
many cells in the grid and during initialization (at startup and when 
changing between calculation models). First make sure that the menu item 
Options  Simulation Display Updates  Simulation Display Progress 
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On is checked. This option defaults to being off because updating the 
colored plot display takes up extra CPU time. 

2. The GFM menu bar will have an item Stop Run while a simulation is 
running. This menu item will change to Done after the simulation stops. 

3. Look at the Windows task bar for the CFD program’s command window 
icon. Click it open to see the simulation status. If the window cannot be 
found, then the simulation is not running. 

4. The Windows task manager can also be checked to see if the melt or 
combustion programs (melt.exe or comb.exe) are running as tasks. 

 
• Remember that every new cycle and change of domain represents a new CFD 

program run and the option settings for each run are taken from the case settings 
for both domains before cycling was started, except for those that must be 
modified for cycling (such as “restart” versus “new start”). Before starting a 
cycling run, set the options as generally desired. Options can still be modified 
during each of the individual runs. 

 
• Sometimes a simulation restart fails. There are several things that can cause a 

restart to fail: 
1. If a grid has been modified, then the simulation must be started as a “new 

run.” 
2. In a series of parametric runs generated using Save Case As (Full Case) to 

create a “good” starting point from a previous case when a parameter is 
changed, the parameter change may be too large. Try changing the parameter 
in smaller increments or using a new start.   

3. When restarting a cycle run, do not open the case; just use the Simulate menu 
to start another cycle. If the case has been reopened, then verify that the run 
parameters are correctly specified for restarting before saving the case. 

 
• There are a couple strategies that can be used to speed up a simulation: 

1. Make sure the menu item Options  Simulation Display Updates  
Simulation Display Progress Off is checked because updating the display 
takes extra processing time. Monitor run status by watching the command 
window or using RunPlot.  

2. Simplify the grid if possible. Make the grid coarser. 
3. It may be possible to increase computational relaxation factors by using the 

Adjust Relaxation Factors Procedure below. However, this is a trial and error 
strategy which may not work. The best situation for its use is to begin with a 
case that has an established flow field and is somewhat converged, as example 
when doing parametric studies based from one converged case that is copied 
as a starting point for using a different value of the parameter being studied. 

4. Reduce the number of iterations for radiation and/or minor species in the 
green boxes displayed when the menu item Properties  Simulation 
Parameters is clicked. This is also a trial and error strategy. 

5. Reduce the radiosity solver loop limits via the menu item Properties  
Radiation Controls. This is also a trial and error strategy. 
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2.  Soot Model Calibration Procedure 
 
In air-fuel furnace simulations, the radiation heat flux solution is very sensitive to soot 
production, distribution, and oxidation. To accommodate simulation with the resources of 
a PC, a reduced two step soot production and oxidation model is used that has four 
kinetic parameters. In air-fuel furnaces, the magnitude of the total heat flux to the melt is 
very sensitive to the kinetic model soot parameters, and these parameters may need 
adjusting for different types of burners, fuel, and furnace geometries. 
 
GFM soot transport is assumed to be governed by the general equation for subspecies 
transport.  Transport of soot as a mass fraction of the gas mixture is then: 
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Einstein index notation is assumed in Equation 2.1, and Ys is the mass fraction of soot, Γs 
is the turbulent diffusivity of soot, and Rsf and Rso are the formation and oxidation rates of 
soot in kg/(kgmixture) per unit volume, respectively. In Equation 2.2, Asf is the pre-
exponential constant in the soot formation rate equation, Esf is the activation energy for 
soot formation, and Yf is the mixture mass fraction of fuel.  Similarly, in Equation 2.3 Aso 
is the pre-exponential constant in the soot oxidation rate equation, Eso is the activation 
energy for soot oxidation, and Yo is the mixture mass fraction of oxygen.  The model 
parameters are the pre-exponential constants and activation energies, Asf, Aso, Esf, and Eso.  
Their default values are given in Table 2.1. 
 

Table 2.1 Soot Formation and Oxidation Model Kinetic Parameters 
Parameter Value Units 
Asf 0.00353 kgsoot/(kgfuel⋅s) 
Aso 30 kgmix/(kgfuel⋅K1/2⋅s) 
Esf 3325720 J/kmol 
Eso 3325720 J/kmol 

 
 
All of these model parameters can be changed by the user. The soot distribution and net 
radiation from soot appear to be most sensitive to the value of the pre-exponential 
constant for soot formation, Asf. Therefore, the automated soot model calibration 
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procedure finds a value of the soot formation kinetic constant, Asf, based on operating 
condition data from an existing furnace or design point conditions for a new design 
combined with an expected efficiency at the design point. In new designs, the calibrated 
soot parameter provides a reasonable baseline from which to test design variations to see 
whether performance improves or degrades. 

 
The soot calibration can also be done for oxy-fuel furnaces, however, soot kinetics are 
not nearly as significant in oxy-fuel furnaces because a large fraction of the radiation heat 
flux comes from the dominant combustion products, carbon dioxide and water vapor. 
 
Step 1.  Open or create a new case in the melt domain just as would be done for a regular 
(non-calibration mode) simulation. When setting the values for items in the green boxes 
(displayed after clicking on the Properties  Simulation Parameters menu item), make 
sure the second line in the left-most green box shows “new start” and the next line has an 
iteration count set high enough to get an established flow field and stabilized bulk melt 
and surface temperature in the melt, possibly as many as 1000 to 3000 iterations. The 
RunPlot program can be used to monitor how many iterations it takes for the mean 
temperature in the melt to begin to go asymptotic. In the right-most green box set the heat 
flux to “scaled”, “uniform value”, and provide an estimated value required for the 
furnace. This value is not significant when “scaled” is chosen because it will be scaled to 
the amount needed by the melt based on the batch inlet flow rate, material properties, and 
the glass outlet temperature. Save the case after the setup has been completed. 
 
Step 2.  Open or create a new case with the same case number in the combustion domain 
just as would be done for a regular (non-calibration mode) simulation. When setting the 
values for items in the green boxes (displayed after clicking on the Properties  
Simulation Parameters menu item), make sure the second line in the left-most green box 
shows “new start” and the bottom line in the same box shows “calc radiation”. The top 
line in the right-most box should show “melt surface: calculated” and the “initial 
iterations” line should show an iteration count set high enough to get an established flow 
field, about 600 iterations is reasonable.  
 
Step 3.  Click on the Properties  Soot Kinetics menu item. A drop-down list will 
appear with lines for soot formation and oxidation kinetic constants and activation 
energy, followed by another line: “Calibrate Soot Kinetics”. 
 
Step 4.  Click on one of the first four lines in the drop down list to pop up a window 
showing the current value of that parameter. Specify a new value if desired. Repeat for 
each of the parameters, going back to the Properties  Soot Kinetics menu item each 
time to get to the drop-down list. The algorithm used in the CFD program will adjust the 
soot formation kinetic constant while the soot oxidation kinetic constant is held constant. 
The adjustment is based on the user supplied fuel and air in flow rate and on the energy 
required by the melter. The correct fuel and air or oxygen flow rates can be determined 
by doing an energy balance on the furnace using a spread sheet.  In addition, the output of 
the melt simulation in the “scaled” mode will provide detailed information on the energy 
requirements for the melt including heat losses from the melt through the walls. This 
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information can be used to determine what fraction of the heating value of the fuel must 
be transferred to the melt, which determines a baseline efficiency. The soot calibration 
procedure will tune the soot production kinetic parameter to match these conditions. 
 
Step 5.  Get back to the drop-down list. Click on “Calibrate Soot Kinetics” to activate the 
calibration mode. (Go back to the drop-down list again to see that the “Calibrate Soot 
Kinetics” line is now checked.) Save the case and get back to the main menu. 
 
Step 6.  Click on the Simulation  Cycle Domains (Melt First) menu item and proceed 
as explained in the GFM 4.0 Automated Cycling Guide document. Set the number of 
cycles to about 20 to 30 cycles. 
 
Step 7.  Monitor the soot_calnnnnc.plt file by clicking on the Options Activate 
RunPlot menu item. The file will only be changed once per cycle, after the wall radiation 
has completed in the combustion domain. If the graphed line for Aform flattens out and 
the “HT to melt” line merges with the “E needed by melt” line, then the calibration run 
can be stopped. When there is a wide difference between plot lines, it may be difficult to 
see enough detail via RunPlot. If so, then look at the soot_calnnnnc.plt file directly, via 
Notepad or another text file viewer. 
 
Step 8.  After the simulation has stopped, if the Aform value has not settled down, then if 
it is oscillating due to overshooting and undershooting the energy needed in the melt, 
more cycles should be run until the Aform parameter has stabilized to 2 or more 
significant digits. If the amount of energy going to the melt is consistently too high, 
increase the value of the soot oxidation kinetic constant (see step 4 above) and change the 
soot formation kinetic constant to the latest value of Aform. Save the case and go back to 
step 6. 
 
Step 9.  When the Aform value has settled down, then set the values of the soot oxidation 
kinetic constant (see step 4 above) and the soot formation kinetic constant to the latest 
values of Aoxid and “Aform” from the soot_calnnnnc.plt file. Also click on the 
“Calibrate Soot Kinetics” item in the drop down list to uncheck it and turn off the soot 
calibration mode. Save the case. The procedure is done. 
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3.  Adjust Relaxation Factors Procedure 
 
Relaxation factors are used to slow the rate of change of variables in the iterative solvers. 
During the iteration process dampening is usually required so that large changes in one 
variable do not cause other variables coupled to the value of that variable to be adversely 
affected, possibly slowly spiraling out of control and causing the computation to diverge 
or oscillate wildly. When a new value for a variable is calculated, that value is actually 
replaced with a fraction (the relaxation factor) of the new value plus the complimentary 
fraction of the old value, thus lowering the value of a relaxation factor will reduce how 
much a variable can change during an iteration (which also may increase the number of 
iterations needed for convergence) and increasing the value of a relaxation factor will 
increase how much a variable can change during an iteration (which also may decrease 
the number of iterations needed for convergence). There is a balance required in finding 
relaxation factors that allow for convergence and do not unduly prolong the number of 
iterations needed to reach convergence. The default values work well for most cases. 
However, in cases that are particularly sensitive numerically, a simulation that does not 
converge well with the default values may achieve adequate convergence if the relaxation 
factors are adjusted. 
 
Default relaxation factor values are provided for the combustion domain in the file 
relaxfactorc.txt in the combustion directory and for the melt domain in the file 
relaxfactorm.txt in the melt directory. These files are read by the CFD codes and hence 
apply to all cases. The information in these files is mapped into the tables below: file 
relaxfactorc.txt corresponds to Table 3.1 and file relaxfactorm.txt corresponds to 
Table 3.2. These tables show the direct association of relaxation factors to data that can 
be plotted via RunPlot (when such an association exists). Notice that each table is divided 
into 3 sections. The first 2 sections are for the relaxation factors and the third section is 
for the number of equation solver sweeps done for particular variables. 
 
The number of solver sweeps controls the amount of computational work done by the low 
level linear solver routines during each global iteration through all of the governing 
equations. Using a very large number wastes computational resources because the 
coefficients are often functions of other variables or of the independent variable (for non-
linear equations) and are therefore only known to limited precision that normally 
increases as the global iteration proceeds. Doing too much work during any one global 
iteration on a single equation can slow convergence because most of the solution 
precision gained in the solution step may be lost when the other equations are resolved 
and the values of coupling and independent variables in the coefficients change. 
However, using too few solver sweeps can result in too little progress being made in each 
iteration resulting in numerical oscillation and a simulation that never converges. 
 
The Adjust Relaxation Factors procedure is usually done to reduce relaxation factors 
when the simulation run is not converging. However, it may also be used to increase the 
relaxation factors. One situation in which increasing the factors might be done is when 
there is a fairly well converged case that is going to be used as a base for several other 
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cases (such as when doing parametric studies) and increasing the relaxation factors might 
produce optimum values that can be used for a set of parametric runs reducing the 
number of days or weeks required to complete the parametric study. Care must be 
exercised under these circumstances to verify that each case in the parametric study has 
adequately converged. This procedure description focuses on reduction of the relaxation 
factors to obtain convergence in cases that do not converge adequately with the default 
values. In this procedure, “modify” and “reduce” means to manually edit the 
relaxfactor[c/m].txt file with a text editor such as Notepad, replacing the default value(s) 
only and keeping the rest of the file exactly as it was. 
 
Step 1.  Determine how to manage the relaxfactor[c/m].txt files. Remember that when a 
relaxfactor[c/m].txt file is changed, the change impacts all cases that will be run 
subsequently in the associated domain. If other cases already exist which might need to 
be rerun or restarted in the future, then it is advisable to make a copy of the 
relaxfactor[c/m].txt file, uniquely identifying it with a new name (possibly including the 
other case number or date in the name). In the future when one of the other cases is going 
to be rerun, then save the current relaxfactor[c/m].txt file with a new unique name, and 
rename the old file back to relaxfactor[c/m].txt. 
 
Just as a precaution, a copy of each default relaxfactor[c/m].txt file, named 
base_relaxfactor[c/m].txt is kept in the documents directory. These files are backups that 
can be copied if the default files are needed again. 
 
Step 2.  Stop the run if it is still active. If the data collection flags were not turned on, 
then set up the simulation again with all the data collection flags turned on and repeat the 
run. Stop the run at about the same number of iterations as before. 
 
Step 3.  Examine convergence data via RunPlot. The governing equation residuals 
provide the primary indicators of convergence. The residuals are normalized by the 
largest term for each computational cell and averaged over all cells in the grid. For most 
variables, the residuals should drop below 10-3. The exceptions are some of the minor 
species. Mass fractions for some of these variables are very small and even negligible 
over most of the computational cells. The normalized mean for these variables, therefore, 
may reflect a value dominated by residuals from cells that have essentially none of the 
species present. Methane, oxygen, and NO, for example, typically do not have mean 
residuals below 10-3 in the minor species residuals plot. For most variables, however, if 
the mean residual plot is not dropping below 10-3, then reducing the relaxation factors for 
the variables that do not meet these criteria may allow the computation to converge. Also 
try to determine if any specific variables are erratic or just not moving in the desired 
direction. If so, then reducing the relaxation factors for those variables may help.  If 
specific variables cannot be identified as causing a problem, then reduce all the relaxation 
factors in the first section of the relaxation file may resolve the problem. 
 
Relaxation factors can be safely cut in half. The penalty for making relaxation factors too 
small is slower convergence (more computation time for a simulation). If settings are 
found that achieve convergence for an otherwise unstable simulation, they can be 
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increased to speed up the computation for parametric runs as long as convergence is 
maintained. 
 
Step 4.  Setup and run the simulation again. If the simulation converges then exit this 
procedure. 
 
Step 5.  Try each of the alternatives below in turn. Setup and run the simulation again 
each time. If the simulation is converging then exit this procedure. 
 

1. Reduce all the relaxation factors in the second section of the relaxfactor[c/m].txt 
file. 

2. Reduce all relaxation factors a second time. 
3. Increase the number of solver sweeps in the third section of the 

relaxfactor[c/m].txt file. 
 
The number of solver sweeps can have a dramatic effect on convergence level as 
measured by the mean residual. It also has a dramatic effect on computation time. 
Because two or more orders of magnitude of convergence in driving down the 
residuals may be lost in the perturbations caused by changes in coupling variables 
over the course of a global iteration through the solver for all of the governing 
equations or in cycling between combustion and melt spaces, the computational 
cost of driving residuals down more than a few orders of magnitude may not 
produce any significant gains. Experimentation with the number of solver sweeps 
can help to find optimum values. 

 
Step 6.  Go through each of the relaxation factors one by one, reduce the factor by a 
significant amount and increase the solver sweeps by a significant amount, and redo the 
simulation. Restore the factor to its previous value if there is no change in the simulation 
results. 
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Default 
Value Item to Relax Data to Check via RunPlot

Relaxation factors for equation loops
0.7d0 general value 
0.7d0 equation for fuel mass fraction Fuel in gresid_xtra####c.plt file
0.7d0 equation for oxygen O2 in gresid_xtra####c.plt file
0.7d0 equation for enthalpy Enthalpy gresid####c.plt file
0.7d0 equation for turbulent kinetic energy k in gresid_xtra####c.plt file
0.7d0 equation for turbulent dissipation rate Epsilon in gresid_xtra####c.plt file
0.7d0 equation for carbon dioxide CO2 in gresid_xtra####c.plt file
0.7d0 equation for nitrogen N2 in gresid_xtra####c.plt file

Relaxation factors for certain variables
0.7d0 general value 
0.3d0 u momentum in x direction (pressure 
0.3d0 v momentum in y direction (pressure 

0.3d0
w momentum in z direction (pressure 
correction) 

0.6d0 density
0.6d0 reaction rate
0.7d0 initial surface heat flux 

0.9d0 minor species
all but last heading in mresid####c.plt 
file

0.7d0 soot Soot in mresid####c.plt file

Number of sweeps in equation solver for specified items
2 general value
2 u momentum in x direction x-momentum in gresid####c.plt file
2 v momentum in y direction y-momentum in gresid####c.plt file
2 w momentum in z direction z-momentum in gresid####c.plt file
6 pressure Pressure in gresid####c.plt file
5 pressure correction        
2 fuel Fuel in gresid_xtra####c.plt file
3 co2 CO2 in gresid_xtra####c.plt file

10 enthalpy Enthalpy in gresid####c.plt file
2 turbulent kinectic energy k in gresid_xtra####c.plt file
2 epsilon Epsilon in gresid_xtra####c.plt file
3 n2 N2 in gresid_xtra####c.plt file
3 o2 O2 in gresid_xtra####c.plt file

1 minor species
all but last heading in mresid####c.plt 
file

Table 3.1: Combustion Relaxation Factors
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Default 
Value Item to Relax Data to Check via RunPlot

Relaxation factors for equation loops
0.4d0 default value
0.4d0 u momentum in x direction x-momentum in gresid####m.plt file
0.4d0 v momentum in y direction y-momentum in gresid####m.plt file 
0.4d0 w momentum in z direction z-momentum in gresid####m.plt file 
0.4d0 enthalpy Enthalpy in gresid####m.plt file
1.0d0 electric potential energy
0.5d0 melt rate

Relaxation factors for certain variables
0.3d0 default value
0.3d0 u momentum in x direction (pressure correction)  
0.3d0 v momentum in y direction (pressure correction)  
0.3d0 w momentum in z direction (pressure correction)  
0.0d0 place holder
0.0d0 place holder
0.3d0 particle number density
0.3d0 particle temperature
0.3d0 density
0.3d0 melt rate
0.2d0 relaxation factor for surface temperature 
0.3d0 down scaling factor for heat transfer from melt surf back into combustion space 

Number of sweeps in equation solver for glass
2 default value 
2 u momentum in x direction x-momentum in gresid####m.plt file
2 v momentum in y direction y-momentum in gresid####m.plt file
2 w momentum in z direction x-momentum in gresid####m.plt file
2 pressure Pressure in gresid####m.plt file
4 pressure correction        
2 enthalpy Enthalpy in gresid####m.plt file
2 electric potential energy

Table 3.2: Melt Relaxation Factors
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Appendix 2 

GFM 4.0 Graphical User Interface Menus 
The tables below list and specify the purpose of the three highest levels in the GFM menu 
system. A “(C)” following a menu item indicates that the item is only present when the 
user is in the combustion space domain. Likewise, an “(M)” following a menu item 
indicates that the item is only present when the user is in the melt space domain. 

Main Menu 
 

Menu Item Sub-Item Purpose 
Pre-Processor  Prepare the inputs required by the GFM 

CFD application code. 
 Combustion Space Select the combustion space domain. 
 Glass Melter Select the melt domain. 
Simulation  Run and monitor the simulation. 
Post-Processor  Examine the simulation output. 
 Combustion Space Select the combustion space domain. 
 Glass Melter Select the melt domain. 
Screen Print  Create a bitmap file of the screen display. 
Exit  Shut down the GFM program and leave the 

GUI. 
Help  View the GFM documentation. 
 
 
 

Initial Preprocessor Menu 
 
Menu Item Sub Item Purpose 

File   
 New Case Create a new case using default settings 

and display its figure view. 
 Open Case Open an existing case and display its figure 

view. 
 Save Case Disabled. 
 Save Case As (Setup Only) Disabled. 
 Save Case As (Full Case) Disabled. 
 Update Case Description Disabled. 
 Delete Case Delete the files for a given case. 
 Delete Case Results Delete only the output files for a given 

case. 
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Screen Print  Create a bitmap file of the screen display. 
Done  Return to main menu. 
Help  View the GFM documentation. 

Preprocessor Menu When a Case is Open 
 
Menu Item Sub Item Purpose 

File   
 New Case Disabled. 
 Open Case Disabled. 
 Save Case Save the new or modified setup files for the 

current case, constructing the grid if it was 
modified or did not exist before. 

 Save Case As (Setup Only) Make a copy of the setup portion of the 
current case using a new case number. 

 Save Case As (Full Case) Make a copy of the current case using a 
new case number. 

 Update Case Description Change or add to the case notes. 
 Delete Case Disabled. 
 Delete Case Results Disabled. 
View  Change between the figure and grid views 

(only present after a grid exists).  
Construct   
 Geometry Set interior dimensions for furnace. 
 Burner (C) Define inlets for fuel and oxygen. 
 Charger (M) Define inlets for batch and/or cullet. 
 Exhaust (C) Define exits for combustion products. 
 Outlet (M) Define exits for melted glass. 
 Components (C) Define doghouses (side wells). 
 Components (M) Define electric boosters and/or gas 

bubblers. 
 Grid Construct the simulation grid. 
Properties   
 Emissivities (C) Specify emissivity for side walls, ceiling, 

and /or melt surface. 
 Glass Exit Temperature 

(M) 
Set the temperature of melted glass at the 
exit. 

 Glass Properties (M) Provide linear function points for the glass 
melt physical properties. 

 Wall Properties Set the wall physical properties. 
 Simulation Parameters Set the simulation run parameters. 
 Soot Kinetics (C) Indicate whether the simulation run will be 

for doing a soot kinetic calibration and 
specify soot kinetic parameters. 

 Radiation Controls (C) Indicate how view factors are kept and 
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modify radiation solver loop limits. 
Options   
 Simulation Display 

Updates 
Turn on or off the refresh of the plot view 
during simulation. 

 Collect Run Data Identify the types of data that will be 
collected during the simulation run. 

 Units Change between SI and British unit 
representation on the display. 

 Feed Units (C) Indicate whether volume or mass based 
feed units are being used on the display. 

 Zoom Adjust the size of the diagram displayed on 
the screen. 

 Diagram Position Adjust the lower left corner position of the 
diagram displayed on the screen. 

 Protect Grid Edits See the status of the “protect grid edits” 
mode and change if desired. 

Screen Print  Create a bitmap file of the screen display. 
Done  Return to main menu. 
Help  View the GFM documentation. 
 
 
 

Grid Construction Menu 
 
Menu Item Sub Item Purpose 

File   
 New Case Disabled. 
 Open Case Disabled. 
 Save Case Save the new or modified setup files for the 

current case, constructing the grid if it was 
modified or did not exist before. 

 Save Case As (Setup Only) Make a copy of the setup portion of the 
current case using a new case number. 

 Save Case As (Full Case) Make a copy of the current case using a 
new case number. 

 Update Case Description Change or add to the case notes. 
 Delete Case Disabled. 
 Delete Case Results Disabled. 
View  Change between the figure and grid views 

(only present after a grid has been 
constructed).  

Options   
 Simulation Display 

Updates 
Turn on or off the refresh of the plot view 
during simulation. 
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 Collect Run Data Identify the types of data that will be 
collected during the simulation run. 

 Units Change between SI and British unit 
representation on the display. 

 Zoom Adjust the size of the diagram displayed on 
the screen. 

 Diagram Position Adjust the lower left corner position of the 
diagram displayed on the screen. 

 Protect Grid Edits See the status of the “protect grid edits” 
mode and change if desired. 

Screen Print  Create a bitmap file of the screen display. 
Done  Return to main menu. 
Help  View the GFM documentation. 
 
 
 

Simulation Menu 
 

Menu Item Purpose 
Combustion Space Start a combustion simulation run. 
Glass Melter Start a melt simulation run. 
Cycle Domains (Comb First) Start a combustion simulation run and 

automatically cycle runs between the two 
domains. 

Cycle Domains (Melt First) Start a melt simulation run and 
automatically cycle runs between the two 
domains. 

Cycle Regenerative (Comb First) Start a combustion simulation run, 
automatically simulate the alternate furnace 
configuration to get an average heat flux 
for input to the melt simulation, and cycle 
runs between the two domains. 

Cycle Regenerative (Melt First) Start a melt simulation run and 
automatically cycle runs between the two 
domains, using the average heat flux from 
simulation of the two furnace 
configurations.  
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Running Simulation Menu 
 
Menu Item Sub Item Purpose 

File   
 New Case Disabled. 
 Open Case Disabled. 
 Save Case Disabled. 
 Save Case As (Setup Only) Disabled. 
 Save Case As (Full Case) Disabled. 
 Update Case Description Change or add to the case notes. 
 Delete Case Disabled. 
 Delete Case Results Disabled. 
Options   
 Simulation Display 

Updates 
Turn on or off the refresh of the plot view 
during simulation. 

 Activate RunPlot Start up the RunPlot program to display a 
line graph for particular data collected. 

 Units Change between SI and British unit 
representation on the display. 

 Zoom Adjust the size of the diagram displayed on 
the screen. 

 Diagram Position Adjust the lower left corner position of the 
diagram displayed on the screen. 

Screen Print  Create a bitmap file of the screen display. 
Stop Run  Stop the simulation run. 
Help  View the GFM documentation. 
 
 
 

Post Processor Menu 
 
Menu Item Sub Item Purpose 

File   
 New Case Disabled. 
 Open Case Select case and display first output 

property. (Disabled after use.) 
 Save Case Disabled. 
 Save Case As (Setup Only) Disabled. 
 Save Case As (Full Case) Disabled. 
 Update Case Description Change or add to the case notes. 
 Delete Case Disabled. 
 Delete Case Results Disabled. 
Options   
 Activate RunPlot Start up the RunPlot program to display a 
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line graph for particular data collected. 
 Units Change between SI and British unit 

representation on the display. 
 Zoom Adjust the size of the diagram displayed on 

the screen. 
 Diagram Position Adjust the lower left corner position of the 

diagram displayed on the screen. 
 Plot Modify the output plot view. 
Screen Print  Create a bitmap file of the screen display. 
Done  Return to the main menu. 
Help  View the GFM documentation. 
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Appendix 3 

Using the GFM 4.0 Graphical User Interface to Build, 
Run, and Review Models: Two Examples 

Introduction 
 
When you enter the GFM GUI you will see the GFM welcome screen which identifies 
the program and shows a picture of the inside of a glass furnace. The most important item 
on the screen is the main menu bar located at the top of the screen just beneath a standard 
window style title bar. By clicking on the menu items you can enter into any of the three 
GFM GUI environments: 
 

1. Pre-Processor – where you prepare the inputs required by the GFM CFD 
application code 

2. Simulation – where you run and monitor the simulation 
3. Post-Processor – where you examine the simulation output. 
 

These environments are kept separate; you must return to the welcome screen to move 
between these environments. Environments are designed so that you can perform your 
work in one session or do some of your work, save it, exit the GUI, and return at a later 
session to continue work on the same or on a different furnace. 
 
 

 
Figure 1.  Welcome Screen 
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Key Terms 
 
Flow Domain.  A glass furnace is divided into two distinct flow domains: the upper 
combustion space and the lower melt space. Usually in this document the word “furnace” 
refers to the half furnace associated with a specific flow domain. The GFM GUI deals 
with each of these domains separately and the GFM CFD application has both a 
combustion code and a melt code used to simulate a furnace. Files created and used by 
the GUI are kept in either a “combustion” or a “melt” subdirectory for the appropriate 
flow domain. Most filenames will contain either a “c” or “m” to identify their association 
with the combustion and melt flow domains respectively. 
 
Case.  Each simulation for a given furnace configuration and set of run conditions is 
identified by a case number. The GFM GUI operates on a case basis rather than on an 
individual file basis. The case creation, modification, and saving of case data are menu 
actions within the combustion and melt environments. Corresponding combustion and 
melt geometries and conditions that are going to be run as a coupled simulation (where 
melt surface conditions are exchanged between the simulations of the combustion and 
melt space) must be assigned the same case number by the user. All the files associated 
with a case will contain the case number within the filename. 
 

Short Work Flow Step List 
Example 1:  Create a new case from scratch,  
Simulate a new furnace design 

 
Start GFM. 
In the Pre-Processor environment: 

1. Select flow domain and create a new case with default furnace. 
2. Adjust furnace dimensions. 
3. Modify/add furnace objects (burners, exhausts, etc.). 
4. Specify physical properties and simulation run parameters. 
5. Build the grid. 
6. View the grid. 
7. Optionally enhance the grid with hand edits. 
8. Save the case. 
9. Leave the Pre-Processor environment. 

In the Simulation environment: 
10. Select flow domain and an existing case to start up a CFD simulation. 
11. Monitor the simulation run. 
12. Use additional monitoring capability. 
13. Leave the simulation environment  

In the Post-Processor environment: 
14. Select flow domain and an existing case. 
15. Look at the simulation output 
16. Leave the Post-Processor environment. 

Exit GFM. 
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Example 2:  Create a new case from a previous case,  
Simulate same furnace with different run parameters 

 
Start GFM. 
In the Pre-Processor environment: 

1. Select flow domain and open previous case. 
2. Save copy of previous case as a new case. 
3. Adjust simulation run parameters. 
4. Return to main menu and proceed with simulation and post processing as was 

done in creating a new case from scratch. 
Exit GFM. 
 

Example 1:  Create a New Case from Scratch, 

Simulate a New Furnace Design 
 
Start GFM 
In Pre-Processor environment: 
1. Select flow domain and create a new case with default furnace. 

• From the main menu click on Pre-Processor to display the submenu showing the 
domain choices. 

• Click on the Combustion Space or the Glass Melter menu item to choose the flow 
domain you want to work in. This action displays a blank screen with the Pre-
Processor menu bar. 

• Click on the File menu item to display the File submenu items. 
• Pass mouse over the File  New Case menu item to get to the submenu showing 

the choices for the shapes of the furnace. For the combustion flow domain click 
on either the Box or Crown Top item. For the melter flow domain click on either 
the Melter or Melter with Refiner item. This action pops up a “Create New Case” 
dialog window listing the cases already in the appropriate directory, “combustion” 
or “melt”. 

• Enter the new case number and click OK to create the case folder and to pop up a 
“Case nnnn Description” dialog window requesting that you enter a title and 
description of the case  

• Enter a short, single line title and/or a multi-lined description for the new case. . 
(You may leave these items blank; they are optional for your use.) Click OK. This 
action gets rid of the pop-up and displays a figure outline of a default furnace. The 
figure is not shown to exact scale. The default combustion furnace has one burner 
labeled b1 and one exhaust, e1. The default melt furnace has one charger labeled 
c1 and one outlet, o1.  

• For the melter with refiner default furnace, the figure has two parts. The upper 
part shows the full melter with throat and refiner components. The lower part 
shows one component at a time.  

• The screen with the figure is called the figure view. 
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Figure 2.  Initial Sample Figure View Showing Melter with Refiner 

 
 

• Now that the case has been created: 
− Construct, Properties, and Options menu items have been added to the menu 

bar. 
− The Update… and Save… submenu items under the File menu item have 

become active while the other submenu items have become inactive. Even 
though you just have a default figure on the screen, it does represent a savable 
case. 

− The case number and title appear on the upper left of the screen display area 
under the menu bar. This information with the case description has also been 
stored in the casennnn[c|m].txt file, where nnnn is the case number. 

− The small green box near the upper right of the figure is a handle that you can 
grab by holding down with the left mouse button and drag to enlarge or 
diminish the figure size. An alternative to adjusting the figure size is to use the 
Options  Zoom menu item. 

− The small green box near the lower left of the figure is a handle that you can 
grab by holding down with the left mouse button and drag to reposition the 
figure. An alternative to adjusting the figure position is to use the Options  
Diagram Position menu item. 

− The current mouse coordinates are shown in the upper right corner of the 
screen. Knowing how to identify a point on the screen may help you to 
position the figure. The figure’s reference position is the lower left corner of 
its box. 
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2. Adjust furnace dimensions 
• Dimension values are for the interior of the furnace without the walls. 
• By default the units are in the SI (metric) system. You may change to the British 

system by clicking the desired unit system item under the Options  Units menu 
item. 

• The dimension labels on the figure are active. Click on one of them to see the 
dimension highlighted in red and to get a pop up window in which you can enter a 
new value. After one dimension is changed, a green geometry list box displays on 
the lower left of the screen showing all the dimensions with values. For the melter 
with refiner, the geometry list box consists of multiple boxes. Click on the 
component names in the first box to choose which component will be displayed in 
the lower part of the figure. 

• Alternatively, clicking on the Construct  Geometry menu item will also display 
the geometry list box. 

• Clicking on any item in the geometry list box or dimension label on the figure 
will allow you to change that dimension value via a popup input box. 

 
 

 
Figure 3.  Combustion Figure View with the Green List Boxes 

 
 

3. Modify/add furnace objects (burners, exhausts, etc.). 
• Submenu of combustion space furnace objects: 

− Construct  Burner (inlet)  
− Construct  Exhaust (exit)  
− Construct  Components  Dog House  (Warning: feature not validated) 
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• Submenu of melt space objects: 
− Construct  Charger (inlet)  
− Construct  Outlet (exit)  
− Construct  Components  Bubbler  (Warning: feature not validated) 
− Construct  Components  Electric Booster  (Warning: feature not 

validated) 
• Click on any of the object submenu items to get to the list box for that object 

where you can add, delete, relocate, resize, or change properties associated with 
the object. Alternatively, click on the top line of the list box to go to the next 
construct menu item. Note that the list box changes for each object and additional 
boxes are added to the right of the first list box as needed for a given item. Update 
the values in the list boxes as desired. 

• Clicking on the second line in the leftmost list box will get to the next object of 
the type identified in the first line of the list box.  

• The list box lines function in a variety of ways when clicked and some changes 
may cause other lines to also be changed: 
− An input box pops up so that you can see the current value and modify it. 
− The value of the line changes to the next value within a predetermined set of 

valid values. 
− Nothing happens; the line is just a heading. 
 

4. Specify physical properties and simulation run parameters 
• Submenu of combustion space properties: 

− Properties  Emissivities  
− Properties  Wall Properties    
− Properties  Simulation Parameters 
− Properties  Soot  Kinetics 
− Properties Radiation Controls 

• Submenu of melt space properties: 
− Properties  Glass Exit Temperature  
− Properties  Glass Properties  
− Properties  Wall Properties    
− Properties  Simulation Parameters 

• Click on the Properties submenu items and update the values as needed. The 
submenu items function in a variety of ways when clicked: 
− Another level of menu items appears. 
− An input box pops up so that you can see the current value and modify it. 
− The value of the line changes to the next value within a predetermined set of 

valid values. 
− The item toggles between being checked and unchecked. 
− Green list boxes appear on the bottom of the screen. Update as needed. 

• Choose whether or not the simulation progress will be displayed on the screen 
(approximately every half minute). Click on either the “Simulation Progress 
Display On” or “Simulation Progress Display Off” item under the Options  
Simulation Display Updates menu item. 
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• Click on the Options  Collect Run Data menu item to pop up a list of the types 
of data to collect during the simulation run. Click an entry to check or uncheck 
which data to collect. 
 

5. Build the grid 
• Click on the Construct  Grid menu item. This action causes the grid to be built 

and displayed on the screen. The screen display is called the grid view. 
 
 

 
Figure 4.  Sample Grid View 

 
 

• Note the following changes to the screen display: 
− The figure is changed to a set of three flat grid planes, one for each dimension, 

going thru the center cell (determined by grid index, not physical position). 
The cells are color coded: 

a. White for open to flow computational cells 
b. Black for walls 
c. Cyan for glass melt surface 
d. Light green for inlets 
e. Bright red for exits  
f. Dark red for electric boosters (melt space only) 
g. Dark green for bubblers (melt space only) 

− The Construct menu item is not present in the grid view. 
− After a grid is constructed a new View menu item appears in both the figure 

and grid views to allow switching between the figure view and the grid view 
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so that you can see how changes in the figure are reflected in the grid. 
Remember that the grid will need to be reconstructed before changes made to 
the figure are reflected in the grid. 

− A Grid Density submenu appears in the Options menu item. Initially, the grid 
is built with uniform spacing except for specific grid lines required for object 
positioning. Optionally use the Grid Density submenu to make the grid denser 
or courser in all or individual directions. A courser grid will shorten the 
simulation time and a denser grid will lengthen the simulation time. However, 
a denser grid may be required for accuracy and to resolve flow features, such 
as recirculation zones within the flow field. 

− A grid control block replaces the list boxes from the figure view in the lower 
left corner of the screen. 

− The location of the current cell is given in grid index values and positions are 
given as distances from the lower left corner of the grid. These values are 
displayed in a box in the lower right corner of the screen. The current cell is 
colored yellow in the grid. The current cell, whose indexes and position are 
displayed, can be changed by merely clicking on the cell you want to make 
current. This action causes the displayed grid planes to change so that they 
intersect the new current cell. 

 
6. View the grid. 

• You can change how you see the grid by clicking on any of the visible cells to 
change the current cell to the clicked cell. Or you could change the planes being 
displayed by clicking in the white space between the grid and any of the labeled 
axes. 

• You can change the unit type via the Options  Units menu item or you could 
click on the unit designation displayed on the x axis label.  

• Look at the grid control block; it will help you view the grid. Consider the block 
as being a table with rows and columns. 
− Column 1 (leftmost) has a radio button for each direction with the associated 

maximum cell index in that direction. (Cell indexes are even, Cell faces have 
odd indexes). The active direction radio button is pressed. You can click on 
these buttons to change the active direction. 

− Column 2 shows the beginning cell indexes. 
− Column 3 shows the ending cell indexes. 
− Column 4 shows the current cell indexes. 
− Column 5 shows the current cell type and color in the second row and a 

dimension indicator in the fourth row. You can click on this indicator to 
change between the flat 2D and grid slices in a 3D view. 

− Column 6 shows a set of grid controls. These controls will vary between the 
GUI environments. Use the top control sweep at this step. Clicking sweep 
automatically displays successive grid planes in the current direction in either 
2D or 3D slices and changes the control label to stop. When you want to stop 
the sweeping, click stop and the label will change back to sweep. 

• Changing values of beginning and ending cell indexes in columns 2 and 3 of the 
grid control block allows zooming in on portions of the grid by clipping the 
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displayed portion to these limits. The resize handle at the upper right of the xy-
plane can be dragged to enlarge the view of the clipped region. 

• Switch back and forth between the figure view and grid view as needed to assist 
in modifying the grid to best represent the furnace.  

 
 

 
Figure 5.  Sample Grid View in 3D Mode 

 
 

7. Optionally enhance the grid with hand edits. 
• Enhancements include adding, deleting, and moving individual grid lines. They 

also include changing grid cell types.  
• Examples of why you might want to enhance a grid: 

− You are particularly interested in the flow pattern near a specific grid object. 
Then you would add more grid lines in that neighborhood to get more details 
of the flow there. 

− You know the simulation will take a long time. There is a region of the 
furnace that is devoid of objects and flow pattern, temperature, etc. are 
expected to change slowly with distance. Then the grid can be made coarser in 
this region by deleting some of the grid lines in this region to speed up the 
simulation. 

− The furnace contains a shelf or baffle. You need to represent those items by 
changing the associated grid cells from the open cell type to the wall type. 

• To add a grid line, select the current cell and direction of the add by clicking one 
of the x, y, or z radio buttons in column 1 of the grid control block. Note that this 
direction choice determines the orientation of the grid line to be added. Then click 
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the add control in column 6 of the grid control block. This action puts a new grid 
line thru the middle of the current cell. 

• To delete a grid line, select the current cell and direction of the delete by clicking 
one of the x, y, or z radio buttons in column 1 of the grid control block. Note that 
this direction choice determines which grid line will be deleted. Then click the del 
control in column 6 of the grid control block. This action deletes the grid line that 
was the lower index of the current cell for the given direction. 

• To move a grid line between the current and the previous cell, select the current 
cell and the direction of the move by clicking one of the x, y, or z radio buttons in 
column 1 of the grid control block. Note that this direction choice determines 
which grid line will be moved. Then click the move control in column 6 of the 
grid control block. This action will highlight in yellow the 2 grids lines that you 
will be moving between and it will pop up a box in which you can specify the 
location you want the line to be moved to between the highlighted lines. 

• To change the current cell type, click on the control in column 5 row 2 until the 
desired type appears. 

• To change the cell type of a block of cells: 
a. Click on the current cell label on the top of columns 4 and 5. It will 

change to select cells. 
b. Move the current cell to the desired beginning location (which is the lower 

left corner of the block you want to change) and click the from label on 
the top of column 2. 

c. Move the current cell to the desired ending location (which is the upper 
right corner of the block you want to change) and click the to label on top 
of column 3. 

d. Click the desired cell type in column 5. 
e. Click the select cells label. It will change back to current cell. 

• Note that the inlet cell type should not be changed.  Inlets are determined by the 
positions of the burners in combustion flow and of chargers in the melt flow as 
indicated by the information from the figure view.  Go back to the figure view to 
change inlets.  

• Note that the exit cell type should not be changed.  Exits are determined by the 
positions of the exhausts in combustion flow and of outlets in the melt flow as 
indicated by the information from the figure view.  Go back to the figure view to 
change exits.  

• Up to this step the information for the figure and grid has been kept consistent. 
However with hand edits, the grid information diverges from the figure 
information and the grid cannot be reconstructed without destroying the hand 
edits. But, you can still switch between views and modify parameters and 
properties. 

• The GUI will warn you about this situation when you attempt to make your first 
enhancement to the grid. It will also put the pre-processor into Protect-Grid-Edits 
mode as indicated by the Options  Protect-Grid-Edits menu item being 
checked. In this mode, modifications which would require the grid to be 
constructed are disabled. You may get out of the protect mode by clicking the 
Options  Protect-Grid-Edits menu item to uncheck it. 
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8. Save the case. 
• Click on the File  Save Case menu. 
• If the grid is not enhanced and the grid has been modified after being constructed, 

then the GUI will reconstruct the grid. 
• The GUI creates three files (where nnnn is the case number and “c” is changed to 

“m” for the melt flow domain): 
− pre-process file, gdnnnnc.pre. This file is needed if you ever want to change 

information in the figure view again. 
− grid file, gdnnnnc.dat. This file is required input to the GFM CFD code. 
− conditions file, sbcnnnnc.dat. This file is required input to the GFM CFD code. 

• In the combustion domain, the GUI will create a default information transfer file, 
itnnnnt.dat, when the melt surface temperature had been specified in the rightmost 
Simulation Parameters green list box.  An itnnnnt.dat file is created during a melt 
domain simulation run; it will contain the calculated melt surface temperature. 

• In the melt domain, the GUI will create a default information transfer file, 
itnnnnm.dat, when a uniform heat flux had been specified in the rightmost 
Simulation Parameters green list box.  An itnnnnm.dat file is created during a 
combustion domain simulation run; it will contain the calculated melt surface heat 
flux. 

 
9. Leave the Pre-Processor environment. 

• Click on the Done menu item to return to the main GUI menu. 
 
 
In the Simulation environment: 
10. Select flow domain and an existing case to start up a CFD simulation. 

• From the main menu click on Simulation to display the submenu showing the 
domain choices. 

• Click on the Combustion Space, Melter, or one of the Cycle menu items to 
choose the type of simulation to run. (For information about cycling, click on the 
Help menu and then on the “Cycling” item in the pop-up box.) This action pops 
up a “Select Existing Case to Simulate” dialog window listing the cases already in 
the appropriate directory, “combustion” or “melt”. 

• Select the previous case you saved in the Pre-Processor by clicking on its 
filename and click Simulate to start the simulation. This action also brings up a 
new screen display that is similar to the grid view with the following changes: 
− The View menu item is deleted from the menu bar. 
− The File and Options submenus have fewer active items. 
− The Done menu item is replaced by the Stop Run menu item. 
− The location box from the lower right corner has been removed. 
− A status box (actually two boxes) is displayed at the bottom center of the 

screen indicating that the simulation is being initialized. 
− The grid controls in column 6 of the grid control block have changed. 
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11. Monitor the simulation run. 
• As soon as the CFD simulation has been initialized and is reporting status 

information to the GUI, the grid on the screen display is replaced with a colored 
plot of the temperature or radiation energy in the simulated furnace and more 
status information is displayed in the status box. This screen display is the plot 
view. It is frequently updated while the simulation runs – for minutes, hours, or 
days depending on the complexity and size of the furnace and the density of grid 
cells. 

• Note that if the “Simulation Progress Display Off” item under the Options  
Simulation Display Updates menu item has been checked, then the grid will not 
be replaced with the colored plot and status information will not be displayed in 
the status block. You can change the display off and on while the simulation is 
running.  Turning the display off will speed up the simulation.  

• You can change the plot from color to black and white by clicking the B/W 
control in column 6 of the grid control block. Then you can change the plot back 
to color by clicking the control again when it is labeled color. 

• You can show the grid temporarily rather than the plot by clicking the grid control 
in column 6 of the grid control block. You can change the current cell position, as 
you could on a grid view in the pre-processor, to see different planes thru the plot. 

• You can pause the plot by clicking on the pause control in column 6 of the grid 
control block and then allow it to be updated again by clicking the (same) auto 
control. One thing you might want to do while the plotting is paused is to click on 
the Screen Print menu item to make a bitmap file of the screen display without 
having the plot changed during the screen capture. 

• The CFD simulation normally ends when either the convergence criteria or the 
maximum number of iterations (previously specified as parameters on the figure 
view) has been met. Then the small box in the upper right corner of the grid 
control block will turn bright green and show the cont label (meaning continue). 
The Stop Run menu item will also change to Done. 

• You could decide to stop the simulation earlier by clicking the Stop Run menu 
item or the stop label in the upper right corner of the grid control block. The grid 
control will change to ending after the request to stop the simulation has been sent 
from the GUI to the CFD simulation. The label will be changed to cont after the 
GUI recognizes that the CFD code has stopped. 

 
12. Use additional monitoring capability. 

• When the CFD code is running, a command prompt window will exist for the 
combustion or melt executable program.  This window is normally minimized to a 
small icon entry on the bottom bar of the screen. If this window does not exist, 
then you know that the CFD code is not running. You can maximize the window 
to see ongoing status information. 

• Click on the Options  Activate RunPlot  menu item to start up the RunPlot 
program which will display lines for various data collected during the simulation. 
Note that you could specify what extra data to collect when you were in the Pre-
Processor environment and clicked on the Options  Collect Run Data menu 
item. 
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• You may start up multiple instances of the RunPlot program. (For information 
about this program, click on the Help menu and then on the “RunPlot” item in the 
pop-up box.)  

 
 

 
 
Figure 6.  Sample RunPlot Logarithmic Display with Legend Window Superimposed 
 
 

13. Leave the simulation environment. 
• When you see the small green box with cont you can restart the simulation run (to 

continue from where it stopped) by clicking the cont or you can return to the main 
menu by clicking the Done menu item.  

 
In the Post-Processor environment: 
14. Select flow domain and an existing case. 

• From the main menu click on Post-Processor to display the submenu showing the 
domain choices. 

• Click on the Combustion Space or the Melter menu item to choose the flow 
domain you want to work in. This action pops up an Open dialog window listing 
the cases already in the appropriate directory, “combustion” or “melt”. 
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• Select the previous case you simulated by clicking on its filename and click Open 
to load the simulation results. This action also brings up the plot view screen 
display with the following changes: 
− The File submenu allows you to open up a different case to look at simulation 

outputs. 
 
 

 
Figure 7.  Sample Plot View 

 
 

− A scrollable list of output field variables is shown in the lower right corner of 
the screen. The first variable in the output list is displayed on the plot. 

− There is no need for the simulation status box so it is not displayed. 
− The grid controls in column 6 of the grid control block have changed. 
 

15. Look at the simulation output. 
• Click on the variable list item that you want displayed. 
• You can use the same viewing techniques that were described in step 6 above. 
• Click on the Options  Plot submenu items or on the controls in column 6 of the 

grid control block to change how the plot is displayed. The sweep and B/W 
controls have already been explained. When you click the grid control, the grid 
lines will be superimposed on the plot. When you click on vectors, the velocity 
vectors will be superimposed on the plot. The grid and vectors will be removed 
when you click on an output variable. 

• You may also start up the RunPlot program after the simulation has been stopped 
by clicking on the Options  Activate RunPlot menu. 
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16. Leave the Post-Processor environment. 
• Leave the Post-Processor environment of the GUI by clicking the Done menu 

item to return to the main menu.  
 
17. Exit GFM by clicking the Exit menu item. 
 
 

Example 2:  Create a New Case from a Previous Case,  

Simulate Same Furnace with Different Run Parameters 
 
Start GFM. 
 
In Pre-Processor environment: 
1. Select flow domain and open a previous case. 

• From the main menu click on Pre-Processor to display the submenu showing the 
domain choices. 

• Click on the Combustion Space or the Melter menu item to choose the flow 
domain you want to work in. This action displays a blank screen with the Pre-
Processor menu bar. 

• Click on the File  Open Case menu item to display a “Select Existing Case to 
Open” dialog window listing the cases already in the appropriate directory, 
“combustion” or “melt”. 

• Select the case filename and click Open to open the case and display the figure 
view. If the case grid had been enhanced then the case will come up in the 
protect-grid-edits mode. 

 
2. Save copy of previous case as a new case. 

• Click on the File  Save Case As (Setup Only) menu item to display another 
“Create New Case” dialog window. 

• Enter a new case number and click OK. The files in the old case are copied and 
the new files are named with the new case number. 

 
3. Adjust simulation run parameters. 

• Click on the Properties  Simulation Parameters menu item to display 
parameter list boxes. 

• Update the parameters as desired. 
• Click on the File  Save Case menu item. 

 
4. Return to the main menu by clicking the Done menu item and proceed with 

simulation and post processing as was done for a new case from scratch. 
 
Exit GFM. 
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Appendix 4
GFM 4.0 Files

This document provides a brief description of files that are created in the process
of setting up and simulating a case in GFM. The number of files that are created
in the course of setting up and running a simulation has been greatly increased in
GFM Version 4. However, file management was also automated in GFM 4, changing
the focus of user work in the user interface and control program to “cases.” The
user interface and control program builds and manages all the files needed to run
a simulation without the user having to open, change, or save individual files when
working in the GFM application. Instead, cases are opened, changed, saved, copied,
or chosen for simulation or post processing, and all of the file operations needed to
accomplish user initiated actions or maintain furnace geometry and operating data are
handled automatically by the control program. Except for files that contain progress
data that can be plotted and summary data, the user does not need to know the
details of file content or how files are used. The files can be divided into several types
that are indicated by the file extension. In general there are files that define the model
of a glass furnace including geometry, material properties, and other parameters of a
case, files that contain intermediate results and boundary conditions that are used by
one of the GFM components, and output files that contain simulation progress data
and results that are of primary interest to the user.

Probably the most useful tables are Tables 2 and 5 that list the files that contain
simulation progress and monitoring data that can be plotted with the RunPlot pro-
gram. The “nnnn” in file names in tables stands for a four digit case number. In
plots generated by RunPlot, the x axis is an iteration count from one of the solver
loops. In many cases it is the iteration count from the CFD flow solver for either
the gas in the combustion space or the molten glass in the melt space. However, in
some cases it may be the iteration count associated with the particular data plotted,
such as radiation solver iterations in a plot of residuals from the equation governing
radiosities in the wall and boundary radiation exchange computation. The y axis
quantities are in SI units: temperatures are in degrees Kelvin (K), energy transfer
rates are in watts (W), etc. The title bar and legend indicate what quantities are
plotted, such as mean temperature in the melt. In cases where the dependent variable
spans many orders of magnitude, the y axis is usually a log scale, and this fact is also
noted in the title bar.

Because the user interface and control program creates, copies, and deletes files
on a case basis and automatically updates and moves control and boundary condition
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files between the melt and combustion space directory case folders for more involved
simulations such as coupled cycling between combustion and melt, the user normally
does not need knowledge of the files used or their contents. However, a list of these
files is provided here for those interested. The files related to building a model, saving
its definition, and controlling a simulation for a case are listed in Tables 3 and 6 with
a brief explanation of content.

Result files summarizing results, giving run termination status and used in post
processing are listed in Tables 4 and 7. The summary files contain information that
appears at the beginning and end of the info files in the relevant case folders in the
melt and combustion space directories.

Table 1 defines the categories of files based on file extension. Table 8 lists miscel-
laneous files not saved in the case folders.

Table 1: GFM File Types
File Extension Type Explanation

d binary simulation state data for restart or other data
dat text data defining grid geometry, simulation setup

parameters, and boundary conditions
out text main output of 3D field variable values for post

processing
plt text simulation progress data that can be plotted

with RunPlot
pre text geometry, parameter, and material property data

used by the pre-processor
txt text various result summary, case definition,

and message files for a case
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Table 2: Combustion Space Simulation Monitoring Data Files
File Name Explanation

conv wallnnnnc.plt equation residuals for radiation wall exchange
convgnnnnc.plt mean and maximum mass residuals
fchgnnnnc.plt relative change in mean melt surface heat flux

from one cycle to the next
gresidnnnnc.plt residuals from gas energy, pressure, and

momentum equations
gresidpnnnnc.plt pre-solve residuals from gas energy, pressure,

and momentum equations
gresid xtrannnnc.plt residuals from major species and

turbulence equations
gresid xtrapnnnnc.plt pre-solve residuals from major species and

turbulence equations
Infonnnnc.plt evolution of energy sources, sinks, and transfers

mresidnnnnc.plt residuals from minor and radiating
species equations

rad detailnnnnc.plt radiation details from volume
soot calnnnnc.plt evolution of values during soot calibration

Tavennnnc.plt evolution of mean temperatures
over the volume, exits, and walls

Table 3: Combustion Space Simulation Setup and State Files
File Name Explanation

casennnnc.txt case title, description, and user case notes
gdnnnnc.dat combustion space grid definition and cell types
gdnnnnc.pre preprocessor data including case geometry,

inlet flow rates, material properties, case
conditions and simulation control parameters

itnnnnm.dat heat flux distribution at melt surface transfered
to melt simulation in coupled simulations

itnnnnt.dat temperature distribution at melt surface transfered
from melt simulation in coupled simulations

itnnnnT relax.dat relaxed temperature distribution at melt surface
used to damp large oscillations in coupling conditions

rgnnnnc.d restart data for gas CFD computation
rrnnnnc.d restart data for gas and wall radiation

heat transfer computation
rsnnnnc.d restart data for minor and radiating species computation

sbcnnnnc.dat setup and boundary condition data
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Table 4: Combustion Space Result Files
File Name Explanation

rtnnnnc.out field variable values over the domain used by
post processor to display and visualize results

runend.txt message indicating normal or error
termination of run

summarynnnnc.txt summary of results of run including energy
and mass balances, in and out flows, energy
transfer rates and losses, and other information

twallnnnnc.txt grid cell array showing wall temperatures

Table 5: Melt Space Simulation Monitoring Data Files
File Name Explanation

convgnnnnm.plt mean and maximum mass residuals
gresidnnnnm.plt residuals from glass melt energy,

pressure, and momentum equations
gresidpnnnnm.plt pre-solve residuals from glass melt energy,

pressure, and momentum equations
Infonnnnm.plt evolution of energy sources, sinks, and transfers
Tavennnnm.plt evolution of mean temperatures

over the volume and exits
Tchgnnnnm.plt relative change in mean melt surface temperature

from one cycle to the next

Table 6: Melt Space Simulation Setup and State Files
File Name Explanation

casennnnm.txt case title, description, and user case notes
gdnnnnc.dat combustion space grid definition and cell types

used to interpolate coupling conditions at melt
surface between combustion and melt grids

gdnnnnm.dat melt grid definition and cell types
gdnnnnm.pre preprocessor data including case geometry,

inlet flow rates, material properties, case
conditions and simulation control parameters

itnnnnm.dat heat flux distribution at melt surface transfered
to melt simulation in coupled simulations

itnnnnm adjflux.dat surface heat flux scaled to meet
batch and melt heat rate needed

itnnnnm relax.dat relaxed surface heat flux distribution used to
damp large oscillations in coupling conditions

itnnnnt.dat temperature distribution at melt surface
rgnnnnm.d restart data for melt CFD computation

sbcnnnnm.dat melt setup and boundary condition data
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Table 7: Melt Space Result Files
File Name Explanation

rtnnnnm.out field variable values over the domain used by
post processor to display and visualize results

runend.txt message indicating normal or error
termination of run

summarynnnnm.txt summary of results of run including energy
and mass balances, in and out flows, energy
transfer rates and losses, and other information

Table 8: Miscellaneous Files
File Name Explanation

cycleInfo.txt temporary file, cycle number from GUI to CFD program
gfm.dat temporary file, status from CFD program to GUI

gui-update.txt temporary file, request from GUI to
change update status in CFD program

kinetic.d constant kinetic data supplied by GFM program
relaxfactorc.txt combustion relaxation factors used to control

changes to computed variables
relaxfactorm.txt melt relaxation factors used to control

changes to computed variables
runs.dat specification of case to run

runstop.dat request from GUI to end CFD program
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Appendix 5
GFM 4.0 Automatic Cycling Guide

1 Introduction to Cycling

Automatic simulation cycling between combustion and melt spaces is a process im-
plemented in the graphical user interface (GUI) and control program of the Glass
Furnace Model (GFM) that allows a coupled solution of conditions in the combus-
tion and melt domains to be achieved with minimal user intervention. The cycling
includes exchange of the common boundary information at the melt surface. This
feature allows a large number of cycles to be carried out without the user having to
copy melt surface boundary condition files between directories or having to manually
start up the computation again in the domain that comes next in a long sequence
of cycles. Essentially all of this can be accomplished in an unattended run in the
domain cycling mode of operation. With this feature the intervals for exchange of
the common melt surface boundary information can be shortened (because no human
intervention is required) providing more frequent exchange of information between
spaces and therefore tighter coupling. Automatic domain cycling can be set for both
regular and regenerative furnace simulations. This document describes the domain
cycling feature and how to set up and initiate automatic domain cycling runs in the
graphical user interface and control program.

Four new menu choices have been added to the main Simulation menu to start up
automatic domain cycling runs. These new Simulation sub-items are:

Cycle Domains (Comb First)

Cycle Domains (Melt First)

Cycle Regenerative (Comb First)

Cycle Regenerative (Melt First)

Selecting one of these menu items pops up a Provide Cycle Information dialog box,
shown in Figure 1, asking for the number of cycles to run, and allowing the user
to change the maximum number of computation iterations to perform for the major
stages of the cycle. In addition, if the option to scale the heat flux into the melt is
on, the number of cycles to continue scaling may be specified. This mode of running
provides a way to approach an expected solution before turning scaling off. If fuel



Appendix 5 80

Figure 1: Provide Cycle Information Dialog Box

flow in the combustion space has been set to provide sufficient energy to the melt to
reach a known glass outlet temperature, scaling ensures that required energy enters
the melt during early cycles when temperatures have not yet approached a stable
mean in both spaces. Note that if the option to scale the heat flux into the melt is
off, then the number of cycles to continue scaling entered in the dialog box is ignored.

After OK is entered for the Provide Cycle Information dialog box, the Select Existing
Case to Simulate dialog box appears and allows the user to navigate through the file
system to the file folder of the case to simulate. If the melt space simulation is to be
run first, the simulation must be started from the case folder in the melt directory.
If the combustion space simulation is to be run first, the simulation must be started
from the case folder in the combustion directory. The case must be set up for auto-
matic cycling in both the melt and combustion space case definitions as described in
the following sections.

Coupling between the combustion and melt spaces is accomplished by passing the
heat flux, both radiation and convection, to the melt surface calculated in the com-
bustion domain to the melt domain and then passing the surface temperature calcu-
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lated in the melt domain to the combustion domain automatically. The user interface
and control program copies the appropriate melt surface temperature and heat flux
distribution files back and forth between the melt and combustion subdirectories.
The melt and combustion spaces are coupled through the energy equation boundary
conditions at the melt surface. In the combustion space, the surface temperature
computed in the melt code is the boundary condition. In the melt space, the sur-
face heat flux distribution computed in the combustion space code is the boundary
condition. Tight coupling between the two spaces requires that these conditions be
swapped frequently. Automatic cycling allows this swapping to be done many times in
an unattended overnight or over-weekend run. The iteration limits set in the Provide
Cycle Information dialog box control the swap points and swap frequency.

2 Cycle Domains Algorithm

The algorithm for automatic cycling of domains with the combustion space run first
is as follows:

1. Clicking on the Simulation→Cycle Domains (Comb First) menu item will begin a
regular combustion simulation for a four digit case number “nnnn” determined
by the casennnn folder chosen.

2. When the combustion simulation stops, a melt simulation is automatically
started for the same case number using the heat flux data from the combustion
domain.

3. When the melt simulation stops, one cycle is complete.

4. The combustion simulation is automatically restarted using the surface temper-
ature distribution data from the melt domain and it runs until it completes (a
user specified number of iterations).

5. The melt simulation is automatically restarted after the combustion simulation
completes.

6. The whole cycling process (repeating steps 4 and 5) stops when a specified
number of cycles has been completed.

The active domain, combustion or melt, and the cycle number are shown in a light
blue box in the lower right corner of the main GFM window when in simulation mode.
The display switches between the combustion and melt space depending on which is
active.

The mean relative change in coupling conditions, heat flux distribution and tem-
perature distribution at the melt surface can be checked to determine if a coupled
simulation is sufficiently converged. If not, another set of cycles can be run. The
mean relative change in coupling conditions can also be displayed as a dynamically
updated plot on-screen (Refer to the RunPlot documentation), and the cycling can
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be terminated when the mean relative change is sufficiently small.

The algorithm for automatic cycling of domains with the melt space first is the same
as that for doing the combustion space first, enumerated above, except that the melt
computation is run first. Both spaces can be sensitive to the boundary conditions
at the surface that they share, and consequently convergence of the coupled solution
may depend on how close the initial guess or starting point is to a converged solution.
Because energy requirements for the melt space can be estimated from batch feed
rates and material properties based on a reasonably close estimate of the melt exit
temperature, a melt space computation done first with scaling turned on may give a
surface temperature distribution that is a good estimate for a first combustion space
computation, if the average melt temperature has begun to approach its asymptotic
value.

If cycling with the melt computation done first does not converge, cycling with the
combustion space run first with a uniform surface temperature based on a good
estimate of expected mean surface temperature may succeed. The melt surface tem-
perature is the primary known surface temperature boundary used in the radiation
enclosure exchange calculation. Wall surfaces use a known heat flux boundary condi-
tion in this computation based on a heat balance at the wall that includes incoming
radiation from the emitting media. Consequently, wall temperatures tend to approach
temperatures that are slightly above the melt surface temperature (just enough higher
to re-radiate the additional amount arriving from the flame minus the amount lost
through the walls).

3 Setup for Cycle Domains

Various strategies can be used to prepare for automatic cycling:

A. The simplest strategy is to set up initial conditions the same as the subsequent
cycle conditions. However, this strategy may require a very large number of
cycles to be run before convergence is achieved.

B. If desired, both or either one of the domains may be simulated for a while inde-
pendently and later restarted for the cycling process. Before doing an automatic
cycling run this strategy could be used to verify that iterating in each domain
was possible or it could be used to establish a basic flow field in each domain
and approach a stable mean temperature. This strategy could reduce the num-
ber of cycles required for convergence, but manual intervention is needed before
the automatic cycling is started.

C. A combination strategy is to set up the initial cycle conditions to iterate long
enough to establish a flow field and approach a stable mean temperature. The
number of iterations in the subsequent cycles is greatly reduced to provide
frequent swapping of surface boundary condition data. This strategy could also
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reduce the number of cycles required for convergence. Strategy C is described
here.

Setting up a combustion first automatic cycling of domains simulation consists of the
following:

1. Create a combustion case and a melt case with the same case number. The
bottom dimensions of the combustion domain should match the top dimensions
of the main melt surface component (excluding refiner area) in the melt domain.

• During the initial case definition, set these necessary combustion parame-
ters:

– While in the preprocessor combustion domain, click on the
Properties→Simulation Parameters menu item to display 4 lists of pa-
rameters in green boxes.

– Click on the second item in the first (leftmost) green box until param-
eter new start is displayed and then set the initial iterations (fourth
line in the rightmost green box) to a number that will allow an initial
flow field to be established, 600 appears to be reasonable. (For strat-
egy B the parameter will be restart. For strategy A and B the initial
iterations would likely be from 100 to 200.)

– Set the combustion parameters to indicate that radiation will be cal-
culated. Click on the bottom item in the leftmost green box until
parameter calc radiation is displayed.

– The radiation interval (displayed in the bottom item of the third green
box) must not be greater than the number of gas phase iterations (dis-
played in the third item in the first green box). interval is the number
of combustion space fluid dynamic iterations between radiation com-
putations that include absorbing and emitting media and the wall and
melt surface enclosure radiation exchange computation. Immediately
after a radiation computation an updated set of melt surface heat flux
distribution values is available.

– For automatic cycling, the iterations parameter should be set equal to
interval. This will cause the updated melt surface heat flux set to be
transferred to the melt computation as soon as it is available. The de-
fault for these values is 200 in the combustion space. More experience
is needed to determine what value is optimum. Any feedback on user
experience would be appreciated.

– (For a combustion space only run the iterations parameter should be
about 6 to 8 times the interval value.)

– Set the melt surface temperature type (in the first item of the fourth
green box). If the melt domain has already been simulated, then the
surface type can be set to indicate that the melt simulation has calcu-
lated the temperature (melt surf: calculated). Otherwise indicate that
the temperature is specified (melt surf: specified) and set the initial
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surface temperature in the next item of the fourth green box. After
the first cycle, the control program will set parameters so that the melt
surface temperature in the combustion space will be the distribution
calculated from the melt domain.

• During the initial case definition, set these necessary melt parameters:

– While in the preprocessor melt domain, click on the Properties→Simulation
Parameters menu item to display 3 lists of parameters in green boxes.

– Click on the second item in the first (leftmost) green box until pa-
rameter new start is displayed. (For strategy B the parameter will be
restart).

– The melt simulation will be done after a combustion simulation so the
heat flux will be determined by the combustion calculation. Set the
melt heat flux parameter to indicate either heat flux: fixed or heat
flux: scaled with the next line showing calc. in combustion. Click
on the second item in the third green box until the desired option is
displayed.

– The heat flux: scaled parameter indicates that the combustion cal-
culated surface heat flux will be scaled to meet heat requirements
needed to reach a user specified liquid glass exit temperature. This
heat requirement calculation for scaling includes heat needed for solids
heating, solids melting, liquid glass heating, melt tank wall losses, and
the heat added by electric boosters.

– In automatic cycling mode the iterations parameter in the melt is
the number of global solver iterations that will be performed before
switching back to the combustion space. Because the melt is essen-
tially a large reservoir it tends to respond rather slowly to changing
conditions, such as an updated heat flux from the combustion space.
Several thousand total iterations in the melt may be required to reach
a converged steady state melt solution. Therefore, the iterations could
initially be set to a large number, 3000 appears to be reasonable. (For
strategy A and B, setting iterations in the melt to a value between
200 and 400 appears reasonable.)

2. After saving both the combustion and melt cases in the preprocessor, go back
to the main menu and click on the Simulation→Cycle Domains (Comb First), to
bring up the Provide Cycle Information dialog box with default values. Enter the
number of cycles to run in this set of automatic cycles if the desired number is
different from the default. The GFM control program keeps track of the number
of cycles in the current set of cycles. If an additional set of cycles is activated,
the simulations will continue where they had left off previously, but the cycle
count itself will begin anew. In other words, the GFM control program does not
keep track of a global cycle count; each set of cycles starts with cycle number
1.
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3. Whereas the parameters specified during the initial case definition apply to the
first cycle in the set of cycles to be done, the remaining information provided
on the Provide Cycle Information dialog box apply to the second and subsequent
cycles in the set. Changing both the number of gas phase iterations per cycle and
the number of gas phase iterations between radiation calculations to 100 may
speed up convergence by swapping heat flux in shorter intervals than the default
200, however, the radiation computation takes a long time, and therefore, doing
it before the flow field has begun to stabilize in the new cycle may lead to longer
convergence times. Some experimentation and watching convergence rates of
the mean temperatures and equation residuals with the RunPlot program may
be necessary to optimize iteration count settings.

4. Note that the last entry in the dialog box is ignored when scaling has not be
specified for the melt surface heat flux. Also, the “total number of cycles”
mentioned for this entry applies to the number of cycles for the current cycle
set.

5. After clicking the OK button on the Provide Cycle Information dialog box, select
the case to cycle from the Select Existing Case to Simulate dialog box and click
the Simulate button to start the cycling.

6. Note that the user may stop the cycling run gracefully during any cycle by
clicking on the Stop Run menu item and indicating that the run should stop
after the current cycle has completed.

Setup for a melt first automatic cycling of domains is similar to the setup for com-
bustion first, except for the melt surface conditions. In the melt domain set the heat
flux: fixed or heat flux: scaled parameter with the next line showing uniform value
and provide that value on the following line. In the combustion domain set the first
line in the rightmost green box to be melt surf: calculated. Also, the menu item to
begin automatic cycling will be Simulation→Cycle Domains (Melt First).

4 Alternatives After Running an Automatic Cycle

Set

The status of a case after automatic cycling is different from the status of a case
after running a regular simulation. When the user saves a case in the preprocessor,
an input file to the CFD code is created from the user’s definition of the case. After
running a regular simulation that input file is still in sync with the case definition.
However, the GFM control program modifies the CFD code input files during auto-
matic cycling, but does not modify the case definition. Therefore, determining what
to do after an automatic cycling run must account for the differences in case status.

After running an automatic cycle set and evaluating the results, the user may choose
to proceed in a variety of ways. The primary options are described below.
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• Start Over: If the run results look bad, then the user may decide to start
over from scratch with different parameter and control settings. The best
way to start over is to get into the Pre-Processor→Combustion Space or Glass
Melter→File menu and click on Delete Case Results. Then the user can open up
the case in the preprocessor, change the case definition as needed, and proceed
from that point with a new start.

• Continue cycling with another cycle set: If a review of results indicates
that more cycles are needed to reach a stable converged solution, another au-
tomatic cycling run can be started and it will pick up where it left off as long
as no changes are made to the case via the user interface that result in the user
saving a changed case. To simply run another cycle set from the state where the
last one finished, the user should go back to the main menu, click on the same
Simulation→Cycle Domains ... that was used before, and enter the appropriate
information in the Provide Cycle Information dialog box.

• Continue cycling with changed parameters: If an automatic cycling run
is to be restarted with changes to operating parameters via the user interface
that require saving the case, then the following run parameters must also be
set to restart an automatic cycling run. These steps bring the case definition
files into sync with the run setup files passed to the combustion and melt CFD
codes during cycling. (Note that automatic cycling cannot be restarted if either
of the grids are modified.)

For the combustion space case, with the case open:

1. Display the green simulation parameters boxes by clicking on the
Properties→Simulation Parameters menu item.

2. If the first parameter under Parameters in the first green box indicates
new start, click it so that it indicates restart.

3. Set the surface temperature type (in the first item of the fourth green box)
to indicate that the melt simulation has calculated the temperature (melt
surf: calculated).

For the melt space case, with the case open:

1. Display the green simulation parameters boxes by clicking on the
Properties→Simulation Parameters menu item.

2. If the first parameter under Parameters in the first green box indicates
new start, click it so that it indicates restart.

3. Set the iterations to the value used for number of melt iterations set in the
Provide Cycle Information dialog box used for subsequent cycles from the
previous cycle set (default 300). This parameter should be set larger if an
operating condition has been changed that would significantly change the
mean temperature of the melt.
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4. Set the melt heat flux parameter to indicate either heat flux: fixed or heat
flux: scaled with the next line showing calc. in combustion.

• Start a new case cycling with changed parameters from the state
of a converged case: If the run results look good and converged, then the
user may decide to use this case as a base for other cases, for example to
do parametric studies. Get into the Pre-Processor→Combustion Space or Glass
Melter→File menu and open the case. Then return to the same menu and click
on Save Case As (Full case) to make a copy of the case using a new case number.
Make operational parameter changes as desired in the new case and proceed as
indicated in the previous bullet item above.

• Stop: If the run results look good and converged, then the user may decide to
do nothing more with the case.

5 Regenerative Furnace Cycle Algorithm

• The regenerative furnace cycle algorithm builds upon the cycle domain algo-
rithm.

• Domain cycling for regenerative furnaces is started via a Simulation→Cycle Re-
generative item from the main menu.

• For a regenerative furnace simulation, two combustion space domain simulations
are done, one for each of the burner and exhaust firing patterns. The setup for
these simulations of alternate firing patterns is described in the next section.

• Both combustion domain simulations pass a melt surface heat flux distribution
to the melt domain simulation and the two sets of data are averaged together
for use. The melt domain will pass surface temperature data to both of the
combustion domain simulations for the next cycle.

This algorithm for simulation of regenerative furnaces assumes that the melt acts as a
large heat reservoir and responds slowly to the alternating changes in firing pattern of
the regenerative furnace. The asymptotic state of the melt for a single firing pattern
may be simulated by setting up a case with the desired firing pattern and running it
as a non-regenerative furnace case.
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6 Setup for Regenerative Furnace Domain Cycling

• Construct burners and exhausts as usual for one of the two firing patterns in the
combustion space grid. Set other parameters as needed for this firing pattern.
Save the setup using a case number, N , where the next consecutive case number
N + 1 is not in use.

• The case number for the 2nd burner firing pattern must be N + 1. A starting
point for creating the N +1 case with the alternate firing pattern may be created
by using the File→Save Case As menu item to save combustion case N as case
N + 1.

• Modify the furnace figure for case N+1 so that the exhausts become burners and
burners become exhausts to create the second, alternative firing configuration
for the regenerative furnace, or do whatever is needed to define the 2nd burner
firing configuration.

For example, for a furnace with one burner, B1, and one exhaust, E1:

1. Add exhaust E2 and set its position to be centered over burner B1.

2. Add burner B2 and set its position to be centered over exhaust E1.

3. Delete B1

4. Delete E1

• Make adjustments to other flow parameters as needed to match the furnace
operating conditions in the alternate burner firing mode.

• Set up the melt space as usual using case number N . Do not set up a melt
space for case number N + 1.

• When all is ready, start an automatic cycling simulation by selecting menu item
Simulation→Cycle Regenerative.
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Appendix 6
GFM 4.0 RunPlot User’s Guide

Introduction

RunPlot is a simple line plotting utility that draws to the screen. RunPlot can be
used to monitor the progress or evolution of various scaler variables during iteration
while running a CFD code. RunPlot can also be used to review the evolution of
these variables after the computation has completed. In the Glass Furnace Model
software, plot data files are generated for a variety of quantities of interest such as
mass residuals, other partial differential equation (PDE) residuals, mean temperature,
and the various global energy quantities, such as the energy loss rate through walls,
q̇wall.

Quantities that Can Be Monitored

Both the combustion space and melt space computations output some files that are
updated after each iteration in the computation with new values of variables that
can be monitored with RunPlot. These files are listed with the quantities that they
contain in Table 1. Files with a c preceding the file extension are located in the
combustion case folders usually in the combustion subdirectory where GFM is in-
stalled. Files with an m preceding the file extension are located in the melt case

folders usually in the melt subdirectory.

File Structure for RunPlot

RunPlot creates screen plots from data arranged in columns, referred to as the data
table, in a selected file. Information on the file structure is provided here so that
the user can add notes to a file without causing RunPlot to fail when attempting to
plot data from the file and so that other files can be generated if desired that can
be plotted on screen with the RunPlot utility. RunPlot is a simple utility program
and is not intended for sophisticated uses or the generation of presentation plots; it
is intended to provide a quick visualization via on screen line plotting of the trends
for variables of interest, or a quick way to later review the progress of a computation
after it is completed. A toggle to change the screen plot background from black to
white is provided so that screen captures can be made that will print on a standard
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Table 1: GFM Files in RunPlot Format

File Description of Quantities
conv wallnnnnc.plt Equation residuals for radiation wall exchange
convgnnnnc.plt Max and mean log mass residual, combustion space
convgnnnnm.plt Max and mean log mass residual in melt
fchgnnnnc.plt Relative change in mean melt surface heat flux

from one cycle to the next
gresidnnnnc.plt Pressure, momentum, and enthalpy log PDE

residuals in combustion space
gresidnnnnm.plt Pressure and momentum log PDE

residuals from glass melt energy
gresidpnnnnc.plt Pre-solve pressure, momentum, and enthalpy log PDE

residuals in combustion space
gresidpnnnnm.plt Pre-solve pressure and momentum log PDE

residuals from glass melt energy
gresid xtrannnnc.plt Major species and k–epsilon log PDE

residuals in combustion space
gresid xtrapnnnnc.plt Pre-solve major species and k–epsilon log PDE

residuals in combustion space
Infonnnnc.plt Energy sources, transfers, losses, combustion space
Infonnnnm.plt Energy sources, transfers, losses, melt space

mresidnnnnc.plt Minor species log PDE residual, combustion space
rad detailnnnnc.plt Radiation details from volume, combustion space
soot calnnnnc.plt Evolution of values during soot calibration,

combustion space
Tavennnnc.plt Volume mean temperature, combustion space
Tavennnnm.plt Mass mean temperature in melt space
Tchgnnnnm.plt Relative change in mean melt surface temperature

from one cycle to the next

printer without using excessive ink or toner. However, loading the data table into a
spread sheet to generate plots with legends, labels, notes, etc. is the expected way to
prepare data plots from the files for presentation. RunPlot does generate a window
with a legend with plot data label text color corresponding to the on screen plot line
color to provide a means to easily identify lines in a plot of many quantities.

To provide flexibility, commentary may appear before, within, and after the data
table (see Figure 2). A line beginning with a “# ” where the “ ” denotes at least one
white space character (tab or blank) and containing the tag plotdata anywhere on the
line identifies the beginning of the data table. The line with the plotdata tag must
appear immediately before, except for blank lines, the line containing the column
headings of the data. The coupling of theses two lines allows the program to identify
the data column heading line and generate legend window text from the headings.
Within the data table, lines containing only white space (blank lines) are ignored.
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In addition, any lines beginning with “# ” as the first non-blank text are ignored.
An end of file or a line beginning with non-numeric text other than “# ” as the first
non-blank text is considered to identify the end of the data table.

The first line in the file is taken to be a title line. Text on this line up to a
“ //” not including an initial “# ” is the title. The title is included in the window
caption. If word “log” occurs anywhere on the title line, before or after a “ //” title
termination, the y-data will be plotted on a log scale. The title line may be followed
by other commentary or data up to the line with the plotdata tag identifying the
start of the data table. A good practice in generating plot files from other software
is simply to begin all lines that are not part of the data table with a “#” character,
indicating a comment line.

The title normally indicates the type of data plotted. It also normally includes
the file name of the data plotted, to allow identification of the source of the data
when multiple plots are displayed on screen. Plotted lines are associated with the
data column via the plotted line color. This correspondence is given in Table 2.
Correspondence between line colors and data column headings printed as text in the
legend window is also established via text and line color.

The format of the data table columns is as follows. The first column of numbers
is assumed to contain the abscissa (x-axis) values. Normally these values are the
integer iteration count corresponding to the ordinate (y-axis) values in the remaining
columns. The data columns are separated by white space, and as many different
variables as there are data columns will be plotted. The numeric data in columns
can be in any number format (integer, floating point, exponential notation). If there
are more data columns than plot colors listed in Table 2, the program will cycle back
through the colors to plot additional columns of data.

Table 2: Plot Line Colors for Data Columns

Data Color
Column Black Background White Background

1 None—x-values None—x-values
2 Red Red
3 Light Blue Blue
4 Green Dark Green
5 Yellow Brown
6 Plum Purple
7 Orange Orange
8 White Black

Operation and Control of RunPlot

On startup RunPlot displays an Open Plot Data dialog box for selecting the file with
data to be plotted. If the file contains a valid data table, plots will be drawn in the
plot window. The plot window caption is composed of the application name, the title,
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if present, and the file name. Resizing the plot window in the horizontal direction will
change the number of tic marks and tic labels on the x-axis. In general the program
tries to put as many tic marks with labels on the x-axis as space will allow while
preserving reasonable inter-label spacing. With this scheme, the tic spacing may not
be uniform. The number of tics and labels on the y-axis is five by default, but may
be increased or decreased via user input.

In addition to resizing the window, user control over a few items of the plot display
is provided by actions initiated by user key press input. Keys and the associated
actions are listed in Table 3. Right clicking the mouse within the plot window will

Table 3: Keyboard Input and Right Click Mouse RunPlot Actions

Key Description of Action
– Decrease font size

+ or = Increase font size
b Toggle between light and dark backgrounds
f Open file dialog box (to get new file to plot)
l Toggle show legend window
y Decrease the number of y-axis tics and labels
Y Increase the number of y-axis tics and labels

display a menu listing the actions in this table providing a means to execute them via
the mouse. When the log of the data is plotted, all integers in the set of the log of
the range of the data are used to label the y-axis. Therefore, when log of the y-data
is plotted, the number of y-tics cannot be changed.

Multiple instances of RunPlot can be run to display and monitor variables from
different files in different windows at the same time.
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Figure 1: Plot with log scale of mean residuals for major species and k-epsilon equa-
tions.
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# Average and max log mass residual // title comment

Summary or other data that won’t be read as plot data:

298 K - Ambient Temperature

101325 Pa - Pressure

# PlotData - tag that identifies start of data table

# iter average mass residual max mass residual

1 0.6577189205781596E-03 0.3483270774362953E+00

2 0.8023438418717733E-02 0.1205137081186856E+01

3 0.1412642398188446E-01 0.1702145623881210E+01

4 0.1864279324049479E-01 0.1198321797782262E+01

5 0.2295087775480696E-01 0.1590848875742073E+01

6 0.2388359323445141E-01 0.1965758786872932E+01

7 0.2005357974720045E-01 0.1699897379301678E+01

# Note in the middle of a data table

8 0.1978368055630363E-01 0.1344666918635310E+01

9 0.1773269006233475E-01 0.1374926758949880E+01

Notes after end of data table.

More data that won’t be plotted:

10 0.1518379910490138E-01 0.1198976665759578E+01

11 0.1393631901720333E-01 0.1554607806217381E+01

Figure 2: Example RunPlot data file.
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Appendix 7 
 

International Commission on Glass Technical 
Committee 21 Round Robin Test 4 and Test 4a 

Specification 
 
Technical Committee 21 (TC21) of the International Commission on Glass (ICG) 
provided round robin test 4 and 4a (RRT4 and RRT4a) specifications for modeling glass 
melting processes. The definition given here is from the April 25, 2004 committee 
meeting in Yalos, Athens. The main parts of the two ICG TC21 test specifications have 
been merged and are shown here: 
 
Melt Specifications 
 
- Kinematic viscosity;  
 νBatch= 0.4 m2/sec                                   for       30 0C< T<1000 0C  
 νBatch =  f(T) , a linear function              for   1000 0C< T<1200 0C 
 νBatch(1200 0C) = νGlass(1200 0C)            for   T = 1200 0C 
 νBatch = νGlass                                            for   T> 1200 0C  and    
 Dynamic viscosity of glass      log η= -1.58+4332/(T-248),   
                                                   with T in 0C and η in dPa.sec                  
 

- Density of glass ρGlass = 2520.8 - 0.138T     kg/m3   T(K) 
- Density; ρBatch = 1400 kg/m3           300 K< T < 823 K and 
  ρBatch = -328.538+2.10029T         823 K< T < 1273 K 
  ρBatch = ρGlass = 2520.8 - 0.138T kg/m3  for T > 1273 K 
 
- Batch reactions take place between 550 0C< T<1000 0C 
- Batch inlet T = 30 0C  
- Batch exit  T = 1200 0C   
- Batch exit start temperature=1200 0C 
- Batch existance temperature interval   : 30 0C < T< 1400 0C 
- Heat of reaction = 750 kJ/kg of glass 
- Ambient T = 30 0C 
 
- Emissivity of batch surface,    εBatch =  0.9 
- Emissivity of glass  surface,    εGlass  =  0.9 
- Emissivity of all walls,             εRefractory = 0.8 
 
- Thermal conductivity of glass  λ g=30 W/m.K 
-.Thermal conductivity of batch  λ b = exp{-3.01943 – (2569.15/(T – 1873.14))}  ;    
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       for  300 K< T <1473 K , where  T is in K and   λ b is in W/(m.K). 
- Thermal conductivity of batch  λ b =λ g = 30 W/m.K   (same as glass)  for   T >1473 K 
 
Other conditions 
- Free grid 
- Batch thickness: 10 cm at the start;  
- Charging temperature of batch: 30oC;  
- Batch is assumed to be fed from the back of the furnace (full width) and  

in the horizontal direction. 
 
- Evaporation of gases from the batch blanket will not be considered. 
 
- Reference T = 1600 K 
- Heat Capacity of glass  CP=1300 J/ kg.K 
- Heat Capacity of batch  
            Cp = 1000 J/kg.K at 300C and Cp = 1300 J/kg.K at 12000C and changes linearly  

for  300C <T<12000C and   
Cp = 1300 J/kg.K  (same as glass)  for T >  12000C. 

 
- Expansion coefficient β=6×10-5 1/K 
 
- Basin walls are 30 cm thick. For exterior heat transfer coefficients, it has been 

concluded to use the previously determined value of 10 W/m2K for convection and 
radiation for both the combustion space and for glass tank. Moreover, since the 
furnace is small, wall losses will be determined for 3-dimensional walls.  

 
- The pull rates are;      
             Case a :  25 metric tons per day               Case b :  40 metric tons per day  
             Batch length 3.0 m                                   Batch length 4.2 m 
 
- The superstructure temperature profiles: 
             Case a;   x=0m: 1300 0C , x=3m: 1400 0C , x=4m: 1600 0C,  x=7m:  1400 0C  
             Case b;   x=0m: 1300 0C , x=4.2m: 1400 0C , x=5m: 1600 0C,  x=7m:  1400 0C 
 
- In cases where the modeling approaches of members do not comply with the   

restrictions specified in this definition they could study the problem with their own 
combined batch models and explain how the conditions are different from the original 
definition. 

 
- Some of the items for the operational parameters might not be justified under the 

boundary conditions yet the principle is to use the same conditions as far as possible. 
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Furnace Geometry 
 
 Top View  
                                                                        7.0 m 
 
 
 
 
 
                                                                          
                                                                                                                                     0.6m  
3.0 m  
  
  
 
 
 
                        3.0 m 
 
 
 
 
Side View 
 
  
1300 C (0.0 m)            1400 C (3.0 m)           1600 C (4.0 m)                 1400 C (7.0 m)        
                                                                                                                                  
                                                                                                                                  Crown 
                                                                            1.0 m     COMBUSTION                 t/c 
                       3.0 m                                                                SPACE                            
 
 
 
                                                                                                                                     0.35m 

1.0 m      GLASS MELT                                  

Batch 
Entry 

 
                                            
 
 
 
Combustion Specifications 
 
Furnace length :  7 m 
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Furnace width   : 3 m 
Crown height from glass surface: 1.5 m 
 
Natural gas calorific value:  5.0x107  J/kg  
Natural gas is assumed to be 100% CH4 and enters furnace at 373K 
 
Total gas consumption: 0.039762 kg/sec for  40t/d     
                                            0.029858 kg/sec  for  25t/d     
                                           
Combustion air input temperature:  1473 K 
 
Combustion air input : 0.71750 kg/sec  for  40t/d     
                                            0.53812 kg/sec  for  25t/d     
 
Excess air: 5 % 
 
Ambient T: 303 K 
 
Side wall refractories wall thickness 30 cm. 
Crown refractories wall thickness 30 cm . 
Emissivity of refractories: 0.8  
Emissivity of batch blanket: 0.9  
 
Firing reversal ratio is to be taken into account with symmetrical averages. 
 
Buoyancy effect will not be considered. But the case might be studied with the  
         buoyancy effect additionally. 
 
Combustion Space and Port Geometry 
 
 
Lateral view                                                                                               
                                                                 
 
 
 
 
 
     
                                                                                                                                    38.0 cm 

 
 
R1, radius for crown;          435 cm 
R2, radius for port crown;  100 cm 
 
 

 37.5 cm 72.5 cm 80.0 cm  30.0 cm 60.0 cm 

     .57 m 

 

150.0 cm  
R1 

R2 

    .57 m 
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Top view for ports and burners                    Side view for ports and burners  
 
 

20 o

10 o

8 o  Burner 

 
 
 
 
 
 
 
                     
                    Burner 2 
                    Burner 1 
                     

 0 o 

0 6 
 
 
 
Number of burners per port: 2 
Burner with a vertical angle of 8 0 and a horizontal angle of 0 0. 
 
-Burner 2x2 cm with 71 m/sec gas velocity at burner tip at 25 t/d(which is close to the 
           80 m/sec recommended during the meeting) and  
           Burner 2.2x2.2 cm with 78 m/sec gas velocity at burner tip  at 40t/d. 
 
Boundary Conditions  
 
- Temperature on inside of crown is specified in above pictures. Radiation models 
           will be used to calculate heat transfer from crown to batch and glass surface.  
-     No temperature gradients to the sides. 
-     At the beginning of the furnace, 0.0 m, the temperature is 1300 C. Then temperature 
           increases with a linear gradient up to 1400 C at 3.0 meter. After that the  
           temperature increases further with a linear gradient to 1600 C at location of 4.0 m. 
-     In the last 3.0 m, the temperature decreases with a linear gradient down to 1400 C at  
           the end of the furnace, 7.0 m. 
- Parabolic output flow in throat exit 
- Participants can use own batch models, use heat sink with value of 750 kJ/kg 
           required melting energy for raw materials and  
           heat dissociation of gases (no cullet). 
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Results and output  
 
- Minimum residence time at throat entrance 
- Mean temperature at throat entrance 
- Location of mechanical spring                              
- Values of velocity vectors in center plane at x= 2.0 meter and x= 4.0 meter 
           and at depths of 0.2 m and 0.7 m. 
- Velocity and temperature plots of central longitudinal plane 
- Velocity and temperature profile plots along the depth at x= 2.0 meter 
           and x= 4.0 meter 
- Temperature profile along the center line of the glass surface and bottom  
           along the length of furnace (about 0.05 m above bottom and  
           below glass surface if necessary) 
- Total wall losses in W 
- Heat balance will be shown  
- Final position of the batch will be indicated. 
 
-    Temperature values of crown along the length of the furnace at the centerline;  
           at x = 0,1, 2,3,4 and 7 m.  
- Side and top view for velocity and temperature contours of combustion space at a   
           cross section through the burners. 
-     Heat flux values for batch-glass and batch-combustion space interfaces.  
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